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Security Manageh Cisco Secure AC®)+ ce >&8.8-12' 1 g!-KZCTI8

ACS 1t Q#YM+|:_ Common Serviced0;, KZ?} Security ManagerSc AUS t-4&«
°TYKS cec —8«°TYp_ —8«°TYKS"EUE£T©OUA&T ACS _$i6 M2
0@6°G\@30%+I1€rM rT"EUEL£T©OUAE>&GbhETAVISc9bg§TAV>T

ACS $i6 KZ878 ®c [Yes] t4E¥KrM M[_"EU£1©UA&1$i6 KZ8+ o

Cisco Security Manager 4.3 -&«°pTOUA& Z—»
| oL-26559-01-



" 5v  8§TA "EULTOUA&b-4«°TY\"pE¢tPi» |
| Security Manager §TA  Common Services >|g AUS b-8«°fY

c [Yes] T4E¥M+\ "EUEL£T©UA&D ACS E£[0¢ 1€S@1” RTYbe«tD—n
@»f€+Su [No] T4E¥M20{@6~rM L ACS §TATQ#YMeMmZb Security
Manager§ TA\ AUS §1A@@7T" RIYTIwKrM

m3p

Security Managel§iA  Common ServicesAUS rScO-4ab Security Manager 8 «°1Y
ERCUOTQ#Y M0 Xb"EUELETOUA&T-8«°TYMe_¢c bm8pt /eeKrM

«,ME 1 —&4«°1Y ER¢UOT°mrSceél@KrM b8NE€?2bi8t /e[ArM

« 8TAb DVD »U-E_ Security Manager&«°1Y DVD t °KrM —8«°iY "E
UETOU&a@+--$x _25-KA?2WS c csm<version> win_server C>Y2/&E b
Setup.exeC“—Yt /e KrM

« Cisco.com”+"3°_R¢-3aKZ http://www.cisco.com/go/csmanageré « Security
ManageriiOiia2_"j-«KrM [Download Software]t j UpiKZ }°1€S
Security Managemb — 4 «°7Y C“-Yt2"aRi»KrM
— WinZip x})°C>Y2bZ6a"+"1»"]b Windows Server 2008 U*KZ8+C*“—

YN°@T,°U, *b8NE?2TQ#YKZ })°I€S GO~ ™" —&4«°iY G-
YEDMMZbGC =Y tMitebi°U[0ZPpKIM A«i@6r~6xCr81eb
°UtQ#YKZCTI8 S\<d C:\Documents and Settinggdministrator\Desktop| ~

c C:T4E¥KZCTI8 30—-c N°C*“—Y\ Liebpi°0U 0Zpl€s -8«
°jY ER¢UODb Setup.exet6a KrM

— C“-YbA&E t0Zp[A~8\8:501 Op-12@rP&YIES cecC Templeb
°Ut5_KZ "-Y«t«YOA&aK C:\Program Files\Comon Files\InstallShieldt
PicUtP7VKZ?} UET°KZV:M@0&KZsZCTIS8

«,ME 2 -—&«°iy “e"i»bee&yg_ ‘8rM —&«°IYp_ b_ b°S@0[OI€rM
« Backup location8"l bAi2U4&b Common ServicesSecurity ManagenrSc  AUS @ M|
_—&«°1YI€Z8 ®c —&«°lY ERCUO_|WZ-4«°TYpbiix
Ef« Api"ME@OA<I€rM Apj”"uET <Me @c Apu{"HE_Q#Y M=
dT4E¥KrM STK Apij"pEc —8«°7Y164 MeS_ <M+G\tNA&K

rm
>&—@>' AUi”’HUE_Q#YMeSu 4E¥Me dc NMSROOTb¥_M<20[@6~rM d
NMSROOTc Security Managera«°7Y tepbj°UlbA«[M tC>Y°c
C:\Program Files\CSCOpx [M "l _ NMSROOToackupt Apj"HE _Q#YK~8|

. @-KzZCTI8

« Destination folder8 "EU£1©UA&T-a«°TYM+C>Y2 Ub d_—-8«°TYM-e

"OMHAA @ NEEdD 1C>Y°TWECErM 1CHYO C>VY2e¥bCrVY2tee
KS cec QbW_C“-Y@N~K~*8G\\ A«i@ 256 eD+6[6+G\T&1 KZ
CTIS8

« Applicationss8 — 84 «°TYM+"EUELTOU& rT Common Services® -8 «°TY 1€
Z878 cec Common Servicest4E ¥ K Z Security Manager Sc AUS t -8 «°TY M
20[@6~rM

e License information8 b8N€? t4AE¥KrM
— License File Locatiorr8 0 —-&8« C“-YbCY A«jt°SM+? [Browse] tiUp

iKZe@KrM 1,0--4« C“-Yt!S_8§TAV 4A*(KZ6WS @c Q

bC“-Yteae [ArM
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§TA "EUETOUA&b"HEC¢PT»

>8@> U--&8« C“—YbA«_c "8A88»& &>'"b'IfeD@Ure€EZ8Zc ~r
Ot

— Evaluation Only>8!“qgb 90 ¥bOUo16ét—¢TEY_KrM

« Admin passwords5 eDeVb admin @71° "« "8%YA«ai» Gb"+"4° O«
01'97+"8° >|g casuser’ s~ 4°b0o(y _X8Zc 20[~§71A @i ve"&
°© X8z >8.5-> tg-KzCTIS8

« System Identity useB© «, 01' 9B 1" \KZQ#YMe"+"&°b @1 " j\A«al»
Cisco Security Management SuitE UET©O U &10 Xb8§TAV_—-8«°TYM+ ec
MmZb8TAV][] LO«,01'9@1" "e“80TQ#YKZCTIS

+ Create casuse8 , K8 -&«°1Y] casusers"4°t8BMe+?]:? Gb@i"~ .
“8°C8BM-20[@6~rM

> @> A«AT»b078BbD7H_PMe-YxU e TUei@6 ¢ Gb”+"84°8Bc
»KMeG\@6~rM Qb|:» eec "«"a°tm-[8BKZ
resetcasuser.exeéba»t /eM«20{@6~rM 00(y_X8Zc /2 A-3
LiaisonServlets UTb NI\P 2 b casuserA«4i»tgl-KZCTI8

«,ME 3 —8«°Ybotc_ 8TA@+--$x_12s-K*8 cec §TAtTI2s-KrM

A ”~ " v d am A A o ” v d A
8§TA EUELETOUab"pECPT»
"EUETOUA&b"pE¢PI»\c ,8AT2042}b1+)TAK @} ,K8AT
2UAb"EUELTOUAT-4«°TYMsER-«[M 3'8®b"HUECDT» Ac@6~r
M
e R1eVY>8,8A12U81"4-8«°TYON_ ,8AT2U&t /eepb§TAV_,K
8AT2UA&T-8«°TYKrM aNbii+@-NI1€ KC-8«°TYIE€SAT
AUA[QH#Y[ATM RTeY "HECPI»t <M+ c bll_@-KZCTIS8
— Gb%'TQ#YM+S _ "HECPI»M MmMZb"EUELTOUA@GKCu+ KZ8
*G\T&1 KZCTI8 rS "HECPI»PIRb"EUELETOUAT-8«°TYM
S _ 17+ Ef«bApij"MET <KZ G-_) ¢KSG\1t&1 KZCTIS8

— 8TAVboelbl,+4¢ ©«,Ov’uECPT»KZ8+ & S\<d Windows
2003 ?} Windows 2008 _"HE¢PT»KZ8e« cec Gb% '@ Q#Y[ArOt oe
IbT,+4¢ ©«,0Ob"pE¢Pi»vie8 @} Security Managert "HE ¢ P 1»
KzZ8e« ec a&f~_ UOI° AUui"pHE [ Y="HECDPT»% ' 'TQ#YKrM

L Security Managel) Ui« H)TaK "@}ceibi,&c¢ ©« , Ot"uE¢tPT»
KZ8e ec ,K8¥A/Ex1+rScaelbi <&t ©«,0lb Security
Managerb&éa/oe >8P.5-13' 0°3UI€Sm8p T /e KrM

> @> Ri*Y "HEC¢bPI»1_ —-8«°TU_|WZ Performance Monitor Sc¢ Resource
Manager Essential® —4 «°1YI€Z28+?2]:2@3*™pujl€rM 8NE? 1X rScg
% @€ 1€ES Performance Monitor or Resource Managssentials (or both) needs to be
uninstalled \8:3801 Op-12128gKZ-8«°T0@) ¢KrM
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| §TA "EUETOUAb"pECPI»

o UO7T>&Apj"nE [/Y-—>>8,K8AT2U4&t U4 §TA>&,8"EUELETOUA @
—8«°TYI€Z8788TA> —8«°TYKZ?} ,8A12U&7}8BKSAU;
"UWE?}11+El«tY-KrM ,K88TAV_—8«°TYMe+ & rSc -4«
°TYtT «M+S_81AT{UT&d@CM>&"EULTOUA&T"4-&4«°TYM+S _
AUi”"HET8BMe> e Gbm8ptQ#YKrM

>& @>' Security Manage§TA "EUE£i©OUAT /ccKZ8+§TAbApuj"nET8BM
*S_ MmMZb-$11+@¥Npu°l€28+G\1&1 M*20[@6~rM

Security Manageth -$ 11+ @3se ™M>|gZ1 1€+G\b& 1 >8P.5-8' T ¢g!I-KZ
CTIS8

e B6EK>8RTeYrScUO1°

"WEC¢Pi»[§71°1€2828,8AT2U4b"EU
£1OUATQ#YKZ8. ecC

2 TUER-«T /eM+20[@6~rM RTeYrScU

O1° "HE¢PI»[811°1€Z28+AT2UA&_ "HECPI»KZ?2} BieVYr
ScUOT° "puE¢bhbi»t «<KrM p6ébATaU&T Cisco.com?}2~"&aR1»K
rm

Q#YpbAT2USA@Wbh/2 68K "PECPT»#Y\KZV3UI€Z>}N ,8:1+1t-N
Me20[@ 6+ cecC 3XeVbp6e”"uECbi»m8pt «<M+20[@6~rM S\<
d Security Manager 3.0.2 }"pE¢PI» M+ ccC 3.22 _"uE¢tpPiT»KZ?}
40 "pE¢tPiI»K 43 "HECPI»M+20[@6~rM
2 5-1 _ "uE¢bi» A«H\_§11°1€Z8« " Co"™"pAT2U& 66Me1 AT
&g KrM

>&@> 33rSc 3317} 43 "HECPi»M. 43b0—-8«[p6&b 4.0—-A«°iY1t,

«°MeG\c[ArOt STK tA—«XbD7H1t2x<"E€d 00oU--4&«[p6éb 4.0
—&4«°TYT,«°[ArM

b"HE¢PT» A<c@8l1°1€28rM
e 40>4.3

e 40.1>43
e 41>43
e 42>43
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M

§TA "EUETOUA&b"HEC¢PT»

P 51 "EUETOU& "pE¢hi» A«

nuE¢

Pi» A §iic1€z8-

« "EUETOUA ,8A720 4 "WE ¢ PT»m8p

RieY |Security Manager 4.3 40 4.01 41 42 1. MmZb-$1T+T¥Np°KrMm Security
Auto Update Server 4.3 Managerb-$ 171+ @3 ™M>|gZ1l 1€+G\b

&1 >8.5-8" tgI-KZCTIS8

2. Qb<[ TGOT™ "t _4«°IYKIM
Security Manage8TA Common Services|g
AUS b-8«°TY >8P.5-2' 1 gI-KZCTI8

3. g¢<_ "HECPI»<b20[*"3fte<rM

"MECPI»<b20[*"5fb « >8P.5-13" 1
gl-KZCTI8

>&@>' 32 Ap° Windows OS_—-8«°TYI€Z8-
Security Manager 4.0-|g 4.0.1¢c UO1°
"WUE¢bi» A« _‘:20@6~rM BT
Y "uEt¢tpbinc 64 Ap° Windows §1
A[bs8§l11°1€Z8rM
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| §TA "EUETOUAb"pECPI»

P 51 "EUETOU& "pE¢hPi» A« >&FA>

nuE¢
bi» A §17°1€Z28-
« "EU£TQU& ,8ATa0 & "nE¢bTi»m8p

UO1e |Security Manager 4.3 40 401 41 42|1. MmZb-$1T+t¥Nu°KrMm Security

Auto Update Server 4.3 Managerb-$ 17+ @3se ™M>|gZ1 1€+G\b
&1 >8.5-8' 1gI-KZCTI8

2. 1T+Ef«tAui”pEKIrM Udjfo "HE
CPT»iblT+ET«bAuj”"HE >8P.5-0'
Tgl-KZCTI8

3. "EUL£TOU&T-4«°TYKrM b8otg
I.KZCTIS8

Security Manage®TA  Common Services|g
AUS b-8«°TY >8P.5-2'

4. 200 _ALZ T+ET«bApij"pEt8TA
_3?23;eKrM

5 1+Ef«tGYKrM §TA 1T+Ef«bY
— >8P.5-12' tgI-KZCTIS8

6. q<_ "ME¢tPI»<b20["rEfTe<rM
"UE¢PT»<b20[*5fb < >8P.5-13" 1
g-KZCTI8

66 K Security Manager 4.3 3.X 1. MmZb-$t1+t¥Nu°KrM Security
Managerb-$ 11+ @3 ™>|gZ1l 1€+G\b
&1 >8P.5-8' tgl-KZCTIS8

2. _ 41 "pE¢pPI»KZ?} 41b-3a«?°
PTOU& Z-»b"HECDPI» 66MevAED
17+&8/cem8ptA _ JeKrM

>2@> rN 41 "uE¢bi»Kz?2} UO1° "l
E¢hPi» A«tQ#YMG\V[ATM

Security Manager b-$ 1T+ @3 ™>|gZ1 1€-G\b&1

Security Manageh"HE¢Pi»tTBEIO+*Su_c aNb Security Managet i+ E i« _
$1+t@Ur€Z8"8G\1&1 M+20[@6~rM -$ tizx\c TxEf«_PKZ
¥Nu°l€z8r811+bG\[M -$1i+@gWZ8+&ShbAT2U4&b Security

Manager?}blizEf«cY-[ArOt Y—[Aebc Apj"pnE\ LAT2U&t
/eKZB8+©«,0V_-$11+@gWZ8+11xET«TE[M

BT H\_3ft3:e ™MrScwlU M«20[@6~rM Approver [aT{CR1 O1»tTQ#YKZ
8¢ ;@c Gb|:"B3&@ ™vVZ1l M+20[@6~rM MmZbtA—«0; \ Security Manager
11+Ef«t $10Su_c MmZbiixb¥Npu°«_ 764t <M+20[v6~rM

o Workflow é¥bOi»[ bm8pt /leeKrM
— 3fT¥NpoMs_c [File] > [Submit] T4E¥ KM
— ¥Npel€zgnrgsfte Mo _c [File] > [Discard] t4E ¥ KrM
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§TA "EUELTOUAb"HECPi» ||
— 9b@T1"b3ft¥Nu°rScé M+20[@6+ ;ec Qb@i"b-poOUAT,
AEDG\@[ArM -p©U&t,AED_c [Tools] > [Security Manager
Administration] > [Tale Over User Session4E¥K z?} [Take Over Session} i U p
KrM
o Workflow O1»[ bm8pt /eKrM
— 3fT¥NMOKZZ1 Ms_c [Tools] > [Activity Manager] T4E¥ KrM  [Activity
Manager]“«&»"2}"i,«A «T4E ¥K [Approve] TiUpiKrMm Activity
Approver T Q#Y KZ8+ ec  [Submit] tiUpiKz Approver _"j A 127
1 Kzv}8rM
— ¥Npel€z87r85ftnU M+_c [Tools] > [Activity Manager] t4E ¥ Kr M
[Activity Manager] "« &»"[ "j,*A +t4E¥KZ?} [Discard] T4AE¥KrM
& [A<bc Edit rSc Edit Openb'gA_6+"j,«A «TE[M
ERA,s C“-Y_PM+3fbY-—
M m Z b Security Manager&«°TY_8CX?bERA . C“-Y@uUr€z8rM Gb
C“-Y_c Q#Yp _8fl€S1i+@-NI€rM
+ $NMSROOTWDC\athena\config\csm.properties
+ $NMSROOWDC\athena\config\DCS.properties
« $NMSROOWMDC\athena\config\taskmgr.prop
Ago

$NMSROOTc Common Services-4«°1Y tepjoU>&1C>Y°c C:\Program
Files\CSCOpx'bCY A«i[M

#~b-8«°TY_PKZ81A« Apuib”"pECPI»rSc—4«°1Yt <KS @b
Security Managetb -8c b\>~[M

e "HECPI»rScgiAc Apij 6064 Me K8C“-YT-8«°TYKIM
o K8C“—Y\Q#Yp_SfIESC“-Y183QKrM

o K8C“-Y\Q#Yp_SfIESC“-Y@$ *» ecI™Iit$IKrM Qb cec
Security Manager@ b|:_ #. KrM

— Q#Yp_SfIESC“-Y T <filename>.org\8:iS[-NKrM

— OFfH#Y\KZ j(C“-Y T <filename>.diff \8: i S[-NKrM
,K8C“—Y\Q#Yp_SfIESC“-VY@$ "*\8: & bI™ItwWEVWS ec
<filename>.org\ <filename>.diff £b_ tQ#YKZ "HE¢bPi»rScg§iA« Apib-4a
«°7YS_ «<SSftERA, -« C“-Y_Y—-KrM

UOi° "puEC¢Pi»ibli+ET«bApi”pnE

CiscoWorks Common Services *T+ET«bApj"UE\Y —_Q#YI£€e« Common
ServicesAui"pE [/ Y-@7,sU,s[ MmZb§TA "EU£T©OUA&bT£ET«1d
#.KrM QbSu Api"HET8BMe«\ 8§TAV_ —-8«°TYIESMm2Zb
CiscoWorks"EU£1©OU&bAui"uE@8BIErM

[ oL-26559-01-J
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| §TA "EUETOUAb"pECPI»

Ajo GbAUij"MEm8pctT+El«bstTApi"uEKIrM —E&° 11+ «°"tAp
"UEM«20[@6° 02C L K8¥AEx1+rScoelbl,s4¢ ©«,0lb Security
Managerb&a/ce >8P.5-13>' 0°3U1€Z8+17% «°” ¥/FETm8ptTQ#YKrM

«,nE 1 Security Managert /e KZ8+8TATApui"uEKZ8+ ecC Security Manager; U -~
&°b [Tools] > [Backup]\8:© UT°eu°t Q#YKZA " nE 1721/2&g [ATM r
S $1T+@¥NUCI€EZ8+G\1&1 KrM>& Security Manageth —-$ 11+ @3 ™ > |
gZl 1€<G\b&1 >&P.5-8' 1 g!->'
Security Managert /e KZ82881Ab cec bm8p[Aui"uE 1121/2&g KM
a. 8TAVb Cisco Security Management Servek j°HE_R¢—-aKrM>& Web EU~" ¢t
Q#YKS8TA "EU£T©OUA&IbR¢-& >8P.6-13" 1 g!->'
b. [Server Administration]A ¢ YT iUuiKrM _ [Server]> [Admin] > [Backup] T4E ¥ K
rm
«,nE [Immediate for Frequency}4E¥KZ 20[_ALZUbGC+1Y» 10, K [Apply] tiUpiK

Z1i+tApi"uEKrM

CLI TQ#YKS8TA 1T+Ei«bApj"pE

Gb8obm8p[c §TAVD Windows ¥D&4» 0 -&?2}«jUE°t jeM«G\_|WZ
§TA 1TxET«TAUj"HEM+%2_ X8Z1 AKrM

17+ Ef«bApni"pEp_ Common Services Security Manageb g% bER-«@ © O
02~31€ I2s-1€rM Security Managemb 12s - @ 6 ¢ Mer[_cX (?2?2+++ 6 @

6+Su 12s-bd¢S 1" @iU-"8°12s - KZKr:G\@6~rM Gb o A

-« TU®ib~s&»~_ error loading page\8: O u-12@/28g 1€ G\@6~rM
CiscoWorks§TAV _—8«°TYIESMmMZb"EULTOQUATAN|"UEMeb _ 1Xb

Api"uE «jUE°K?Q#YI€rOt T9b"EUELETOUATANi"HE[ATO*F

Ago GbAuj"uE ¥Pa&»cli+Efl«bstApj"pEKrM —E&° 11 «°"tAu
i"UEM«20[@6° c2C ,K8¥a/Ex1£rScaelbi «a¢ ©«,0lb Security
Managerb&é&/oe >8P.5-13' 0°3UI€Z28+17% «°” ¥/FETm8p T Q#YKrM

«,ME $11+@¥Nu°l€Z28+G\t&1 KrM>& Security Manageb —-$ 11+ @3a& ™ >|gZ

11€<G\b&1l >8P.5-8' 1 g!->'

¥Pba» ERAE?] net stop crmdmgtd \°SKZMmZbER-«t 6 FKrM
b¥PDa&»1t°SMeG\_|WZ 11+Ef«tApi"pHEKIM

$NMSROOin\perl SNMSROOWin\backup.pl backup_directonflog_filename

[email=email_addresgnumber_of _generatioNsompresg]]]

ic b\>~[M

« $NMSROOF8Common Services-&«°1Y tepijoUbCY A«i>&1C>Yoc
C:\Program Files\CSCOpx

« backup_directory8 Aui"pEt8BMelebioU C:\Backups~][M
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§TA "EUETOUA&b"HEC¢PT»

>@>>' AUui”"HE_Q#YMeSu 4E¥Me« dc NMSROOTbY¥_M<20[@6~rM d

NMSROOTc Security Manager 8 «°1Y tebj°UlbA«[M tC>Y°c
C:\Program Files\CSCOpx [M "l _ NMSROOToackuptApi”"uE _Q#Y K" 8|
. @-KzZCTI8

« log_filename8& ;e E©QU &> Api"uEp _#OBI€«Opu-12#YbR ¢ C“-Y #~b
tepjoUe¥b d_Apij"uET8BMe ec QbA«134a<KrM
C:\BackupLogs®][M iSte&e KA"?WS oc $NMSROOTog\dbbackup.log_" ~r
M

+ email=email_addresss& ce E © U &>'30%z+ t3&e MM «7TAEOTY' » b« TAEOTY "» P«
cae K"8@ JFbAUOT+tce M+20[@6° ceC §—-rSc”"»bP« @M+ K
~8 email T°SKrM CiscoWorks Common Servicds SMTP 10¢ K Z 30%+ t—¢ TEY
_Me20[@6~rM

e number_of _generation8& «c EOU&'Apij"pE tebj°U_-NKZ>CAuj”"nE
bgtaaeX qxX_4) M\ ,8Aui"HUE@P7VIErM 1C>Y°c 0[ -NI
€eaxeX_D7/Hc6~r0O%

o compress8& @ EOQU&'AUi”"pE C*“-YT}D°Me?]:2 GbYiai»t°SK~
8\  backup.propertieC “—Y £ _ VMS_FILEBACKUP_COMPRESS=NC@ & |€Z28-
o AUj"HEC])°I€rOF & 1€2878 ec GbVYiai»t°SKACZ
VAU{"HEC)°I€rM Api”"HECc)°M+G\tTNAKTIM

S\<d _&gI€Z8-¥Pa&x»c perl ¥D&»\ backup.pl¥D&»@N~Me+teb;°oU

[$/leMsG\te KZ8IM >& STK OfitepijoUb ce[v DOS 8.1g">& « 11«

ANK>'b62Y8IIE€S perl \ backup.plb§22A«tae M+20[@ 6~rM>'

_&Q1€Z8+¥P&x»[c Api"pE lepioULE N IE€SApj"HE>|gRC

C“-Y@8BI£ admin@domain.com 30%+ @3 ™I €rM

backup.pl¥D&» T Q#YMe ¢ }N)°AUOT+tpus_cAuj"uEasetae M20[@

6~rM

R¢ C“—Y AUOTzbce _AUOT£t@ Mes ec s/eMeMmZbAUOT£bIt

Hue20[@6~rM

b[[c $NMSROOTc D:\CSM [6~ tC>VY°ib C:\ProgranFiles\CSCOpx[c 6 ~r

Ot

D:\CSM\bin\perl D:\CSM\bin\backup.pl C:\backups C:\backups\backup.log

email=admin@domain.com 0 compress

B¢ C“—V11l* KZ 1T2ET«@APNi"HEI€Z8+G\T&1 KrM
¥Pa» ERAE°] net start crmdmgtd \°SKZ MmZbER-«T12s-KrM
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| §TA "EUETOUAb"pECPI»

§TA 11xE

«,uI'E 4

T«b¥Y-—

¥PDa»U-82}«jUE°T JeM+G\_|~ 11+ET«TY-[ArM 1+bV—p

_ CiscoWorkst© O p°2~&8Kz?}12s -M+20{@6~rM GG[c §TAVbA;

"UE 17xET«tY-Me%2 X8Z1 AKrM Apj”"uE>|gY¥-bSubu+c 1
XTE[6~  CiscoWorks§TA —-8«°iYI€Z8+MmZb"EUELTOUATAN| "1
E>|gY-[ArM ¥ b’EUL£TOUA&TAU{j"HErScY-M+«G\c[ArOt

0 Xb8TA "EUEL£TOUAT-8«°TYKS ec —4«°1YI€Z8«"EUELTOU

8 4KS1+@ur€-ti+Ei« Api"HETY-M+20[@6~rM

Ago

e eSbUUT«b"EUETOU&?}8BKSANj"uEc GbAT2UAb"EUET
©Ualb2-pj° RieY —-40-8 "pECPI»@8iT°1€Z8+ATaU4&7}
bApui"HE[6€d Y-[ArM "uE¢Pbi» PAKSA{T2UA&b0od(y X8Z
c 8§8TA "EU£1OU&b"uE¢hi» >8P.5-5' 1 gl-KZCTI8

« restore¥PDa»c TxET«bstY-KrM —E3° 11t «°"t1Y-M+20[@6
« ®cC ,K8¥8ExixrScoelbi, «4¢ ©«,0lb Security Manageb&a/ce
>8P.5-13"' 0°3UI€Z8+11+ «°” ¥/ETm8pTQ#YKrM

m3p

¥PDA&»U-&[ b|: _°SKZ MMZbER-«T8FKrM
net stop crmdmgtd
b¥D&»tT°SMeG\_|WZ 11+Ef«tY-KrM
SNMSROOWin\perl SNMSROOin\restorebackup.pl [-t temporary_directory
[-gengenerationNumbér-d backup_directonj-h]
ic b\>~[M

« $NMSROOP8Common Services-4«°1Y tepj°oUbCY A«i>&1C>Y°c
C:\Program Files\CSCOpx

o -t temporary_directory8& ®c EOU&>'Y-ERCUO[MIC“—-YT-RNMe+Su_Q#YIE
elepijoUrScC>VY2 1C>Y°[c Gbtebj°Uc
SNMSROOTtempBackupDatd M

« -gengenerationNumbe& e EOUA&>Y-Ms+Apj"uEaax$« 1C>Y°[c q,b
ae[M" 1> 5a:e@N~Me ec” 5ase@q,[M

o -d backup_directory8 Y - MeApi"uE@-NI€SApi"nE lepijoU

e -h>8& 86 —>EYE 1&g KrM -d BackupDirectoryt Q#Y KS cec EYE_GK8Se\
Q#Y o+ N«—1°>|gae @P&YIErM

S\<d c:\var\backupt+sbi°U?}qg,bAT2UA&TY-M+ cec b¥Da»t°S
KrM>&G€c 64 Au° OSb ce[M>
C:\Progra~2\CSCOpx\bin\perl C:\Progra~2\CSCOpx\bin\restaebackup.pl -d C:\var\backup
R¢ C“—Y NMSROOTog\restorebackup.logtl*mz 11+ET«@Y-1€SG\1&1 K
rm
b|:_°SKZ ©«,0tlI2s-KrM
net start crmdmgtd

Cisco Security Manager 4.3 -&«°pioU4 Z—»
OL-26559-01-J



" 5 §TA "EUEL£TOUAb-A&«°TY\"uE¢DPT»
M

«’uE 5

,K8¥3/ExitrSceelbt, -a¢ ©«,0Ib Security Manager b&a/ce M

Security Managel8TA« Apijb—-8«°TYS_AUi"HEIE€S11+ET«tY-Me
ec T+ET«bY—-<_8§TA« AUuitl4a#YM20[@6~rM

"WE¢PT»<b20[A&fb «

"EUELTQUAT"UECPT»Me\"l b_ b# %2@SfWZ m-[$fKA"E£d
AIACPre e@6~rM GbAT2U&D0 _"UECPT»KS} WDb20[~&fU «©
tglKZ"g#_efOZSft4#YM20[@6~rM

e 33.1|~&SbAtaU&?}"uE¢tPT»Me cec 4 11°  Gigabit Ethernet Fiber &
£TC™_« eT»>&AT»~™" +-E>8i82571EB4B' @ /= 1€S ASAB55801A—-«V
[-4E&°0Utie M+20[@6~rM —3E&°Ubie |WZ TA—«V[b3y
@8 ¢ 1©871°0¢; t8f[A*8&SbUUT«?}bA¢t@0Zb61€rM —8E&°0U T
iée M+ ¢ Security Manager, U-"8°b 1A -« Axi[tA-«tjUpiKZ
[Discover Policies on Devicel4E ¥ Kz ?}  [Policies to Discover]¢ YTE £ b [Live Device
discovery and only the Inventorg|™ piTpuj«ted_KrM ie _|WZ tA—«_
BOMe—&+IC™—-« [UOT@*AN<}€rM

e 33.1eSbAT2UA&?}"UEC¢tPT»KZ>~ «§l1°btwlifo "2E +>& SPA>'
t Q#Y M+ Cisco ASR 10000 UT- "¢UntOU8 §TA« Yix16#.KZ8e ec
Security Manage{ §ii°1€z8+-AT2U4 40e7Fb SPA@e [A+|:_ A
—«_ 66MTUOTTIE& Me20[@6~rM ,KC8§ITOI€e SPA ¢ Mm2Zb
—18¢u>&MmZb3y@> o©U”Y ATM >|g Packet over SonefPOS>'SPA @ ur €

rM@ §TA« SPAcpure€rOf tA-« CLI[ ATM PVC rSc2-0U684 1U
©110¢, KS cec 1& @20[[M

 K8¥AaALE xT+rScoeibi,*a¢ ©« Olb
Security Manager b&a/oe

>& @>'

Security Managert , K8 8§1A_&&/e K "E€d*}"8 c@6~rM Gb&i/le T,K 8" @#.

¥&Ex1+ PKZle: e\ §81AVbelibi, <&¢ ©«,0_02a01 "uE¢thbIT»
t«M ce>& Windows 2003?} Windows 2008 _&a/ce M+ "> @6 ~rM

Security Manageb A12U&c3fK"8@ "@# AT»"™"rSceelbi, *a¢ ©«. 0
tT8fMe cec &A/EER-«T304#M*+20[@6~rM Gb&A/ER-«C 6 $x _ §1
A"EUET©QUAb"PpEC¢tDPT» >8P.5-5' 0°3U1€728.001° Apui"uE [Y-"pE
¢thPi» ER-«\ LVb[M@ Event Managerti+z «°” —NI€St1+t&&E/e M-
cecl3deb«,  UE@20[[M Security Manage8 1A b&a/et <M+ ec Gbmspt Q#Y
KrMm

elbT,+&¢ ©«,0 _PMebD-Yl §1A« Api "puE!i°c Q€@ Security
Manager§ T A&&/e0[6 _~er[ "HECDPI»\cOb " 1€r0OF §TA&A/ec cIbi

*4¢ ©O«,0ObG'i&a@53fl€+ ceb|:_ $72+0207 AtaU8beelbT, .

4¢ ©«,0 "t&A/leMe 0 _20[_~~rM
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,K8¥&AEx12rSceeibf,+4¢ ©«,0lb Security Manager b&a/ce
cCLueS_
Gbm8p[c #fape° § 1 A>& Security Managert&i/oe M« §TA>' _ T« ¥YAAEXxT+\
Lif+Ef«\-EA4° 11# «°"b/E t-NMevb\KrM £Topo §TAV]
Security Managem Q#Y 164 KZ8+ c 1« ©«,0\tTop° ©«,0blizET
«rSc—-E4&° 17+ «°"tTDbi2[ArOF £7ap® 1T+t T« IT£[*(An<e
0[@6~rM &4i/eS_+iap® ©«,0V_N~KZ8SMmMZbli+@ &Fle6¢<_Q
#Y[AACA~rM ,8+7ap® ©«,0 17+t ,KC&H/MC>Y2_¥AETK"8[C
TI8
rs —gae° 11+ «°"b¥AE1>|gY-«,UEc QbiTxt-NMe e _bs20[
"G\_@-KZCTI8 ,K85b-EA&° 11+ «°"?} ue ;ec Gb«, pE 1%,
$[ArM
«,ME 1 "1« Security ManagegiA>&&4a/ce —b&TA>V[ bm8pt /eKrM
a. —E&° 11+ «°” C>Y2biSt"l KrM Security Manager U —"a°] [Tools]
> [Security Manager Administrationf4E¥K ¥a af ,TEY?} [Event Management}
4AE¥KrM C>Yz2c [Event Data Store LocationG «7Y » _/2&g1€Z8rM 1C>Y

°c NMSROOTMDC\eventing\database[ NMSROOT c-&«°iVY tepijo (&30 -c
C:\Program Files\CSCOpx[ M

b. ¥P&»U-&[ b|: _°SKZ MmMZbER-«T8FKrM
net stop crmdmgtd

c. NMSROOTMDC\eventing\config\collector.properties C“-Yb¥ £1\-E&° 1T+ «©
" C>Y2t8BKrM Qb¥AETt+iop° YAAEXT£?2} j-«ot Mo
4A* (KM

d. CLI TQ#YKS8TA 1+ET«bApuj”uE >8P.5-10' 0°3U1€728.¥Pa»U-4

%'t Q#Y KZ Security ManagerizEi« TApi"uEKIM
«,ME 2 ,K8tfaop®° ¥aExTtt= KrM _[t&KrM

e« celibf, sac¢ ©«,0Ot"HECPTI»M+TE[ ,K8AT»"™" &&lceK" 8 ce
c ceibT, sa¢ ©«,0 "HE¢DPiI»t <KZ ceibi, c&c¢ ©«,0@GKC
pt KZ8+G\1&1 KrM Qb«<] Security Managert -4 «°TYKrM

e K8¥aAxTt &ileMe+ ec Qb¥AAExT+@GKCu+ KZ8+G\1&1 KZ

Security Managert —4 «°TYKrM
«,JE 3 +7op° Security Manage®i1AV[ bm8pt /e KrM

a. ¥Pa»U-8[ b|:_°SKZ MMZbER-«t86FKrM
net stop crmdmgtd

b. §TA 171+Eif«bV- >8P.5-12' 0°3UI€Z8m8ptQ#YKZ 1T+ET«tVY-K
rm

c. TxET«Y-bo6¢c« ER-«TI2s-KA"?2WS @c GG[I2s-KrM
net start crmdmgtd

d. Security Managern U-"8°t Q#YKZ ,K88TA_R¢-&4KZz?} [Tools] > [Security
Manager Administration]f4dE¥K Z % ?} [Event Management}f4E ¥ Kr M

e. —E&° 17+ «°" Cr>Y2@N-~K Q€E@5[6+G\t&1 KrM>&20[ _ALZC*"
—-YTP7VKrM> GbC>Y2 ¢ "1« §TAVb-E&®° 1% «°”\ LjS\
dt0, M«20[@ 6~rM
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Security Manager bf, ||

f. G K8 [Event Data Store Location&:1C>Y°@ GK8C>Y2["8 > T4E¥KZ
[Enable Event Management]™ pijTpj«teC_K Event Manage8iA«t6FKr
M [Save]tTiUpiKzZsft—-NKrM 81A«t6FM+?]:?2b&1 @O[OI1€r
M [Yes] TiUuiKZ8TA«bB8F @30%xI€er[...UrM

g. Apj”"pEI€S—-EA4° 11 «°"1 T« ¥AExT£?2}xTop° §TAVb,K
8 d_¥/ETKrM

h. Api”HEI€S NMSROOTMDC\eventing\config\ollector.properties C“-Y T 1« ¥

AExT+2}+iop° YA/ExT+ ¥AETKZ +Tapo° §TAVbC“-YTViA
KrM
i. Security Manageri U-"4a°] [Tools] > [Security Manager Administrationf4E ¥ K ¥ &,

&7 ,7EY?} [Event Managementf4E¥KrM [Enable Event Managemen]™ p;ip
j«toed KzZ [Save] TiUpiKrM 81A«t6a M+?]:?2b&1 @O[OI€r
M [Yes] 1iUpuiKZ8TA«b6a @30%xI€«r[..UrM

Security Manager bf,

—4«°1VYi_1,0--8« C“-Yte [ATM@ Security Managef —8 «°TY « _
vO--&«t38<[ArM AUS cU--8«cYOQ[[M

cCLueS_

U--8« C“-Yt81TA DPoO©&rScjl0-"4a° Poa_¥ETKZ?} U--8«t"E
UETOU& 3a-KrM jU-"4° DO&TQ#YMe ec jU-"8° bEU""t-

¢TEY _Me20[@6~1rM

>58@> U--8« C“-YbA«_c "8A8a»& &>'"Nb'IfeDP@uUr€z8Zcr~r0Ot
Ao Security Manager R ¢ —aMs7e _U—-&4«T4#YMG\V[ArM Security Manager? }
Upgrade licenser S c Continue Evaluation\8: O u-12@/2&g | €rM [Upgrade

License] T jUpiMeG\[ U—-&«T4#Y[ATM

m8p
Security Manageb U —-8«t-&«°TYMe+_c bm8pt /eKrM

Re¢—-aKrM>& Security
>8P.6-1%' 1 g!->'

«,ME 1 Security Manager U-"8° "EULTOUATQ#YKZETA
¢-4a
«,ME 2 [Tools] > [Security ManageAdministration] t4E¥K ¥3a &1 ,TEY?} [Licensing] T4E ¥K

ManageriU—-"4°t Q#YKS  Security Managel b R -

rm

«,JE 3 +E@"j,*E_~WZ8"8 cec [CSM] tiUuiKrM

«,ulE 4 [Install a License]tjUuiKz [Install a License]2—="R¢Tuj«t6aArM Gb2-"R
CTpj«TQ#YKZ U--&« C“-YT4E¥K [OK] 1iUpiKrM GbER-«T)p~

BEKZUbU--4«133a<KrM

Cisco Security Manager 4.3 -&«°pTOUA& Z—»
| oL-26559-01-



" 5V §TA "EU£1©OU&b-4«°TY\"UEC¢DPIi»

| §1A« Apj\i-ac° Ap3b°m

>&@> A«\C“-VYic el b”"YC“Ep°edD D7HIErM ¥+l ebDc§ii®le
rot Windows¥+l OS©« O[C“—Yt4E¥Me+ cec 30-bC“-V

P\ @S8IT°I€ErM@ GE€cC0°>& U+00AS>"\K ZP&Qg 1€+ G\ @ 6 *

~M20[@6~rM

)~e
G\ _@

§TA« Apj\i-4° Ap3be°m

@- Security Manageh 8 1A«  ApjrSci-4c° Ausc ©«¥?2}°mKZCTI8 Q
€e¥bC“-Y12"4RT»KS~ 648S~K""8[CTI8 §i»AfT, 0 b§TA
« Apj\i-4ae Apscsgiicl€zsrot
Security Manager ScQbUb"EUEL£TOUA&AT-8«°TYKS} ©«¥?2}°mKSE&1
A« Apjrsci-4ace Apust-8«°TYKZ A¢tYYKS~ K81A-« +—Et
§11°KS~ "EUELTOUATIIKS~[ArM
o ,K88TA« Apibeme+t "111t%xWZ 20[*§71A« Apit2"&Ri»Me_

¢ Security Managert6a 8 Z [Help] > [Security Manager Onlinef4E¥KrM rSc

http://www.cisco.com/go/csmanager” j - « Kr M

e« 0 ?} CiscOTACS8TA« Ujs«°@f 1€\ TAC @ Qbe8Yb0Z6 _zgXeT
6abT—-8° Au3@6¢?]:2130%xKrM GE€&¥b% 2] Security Manageli — & °
Aus@4Ax1€+G\c6~r0t
§TA« Apj\i-ac° Apsc j0-"4c° Tgo~m™»  "pE1f° §TA gifot
fiKk j0-"8°\87A66bAT2U4 PEYbN«Pus3te KrM
A " ” r 4 am A - ° ” ° ° A r'd
8TA EUETOUab”a—-a«°lY
§TA "EUELTOUAT"8-8«°TYMe_c Gbm8ptQ#YKrM "EUE£T©OU&T
"8-8«°TYM+S_ "EUE£TOUAbLI-8«°TY@20[" ce_17xTY—[A~]
_AUj"UEDb <t@é0!KZCTI8 Apij”"uEb <% 2_X8Zc Ubi°e "uE
¢tPi»ibtT+El«bApi”"pnE >8P.5-' 1g!-KZCTI8
cLueS_
8-bAiaU&b Windows Defender@ -4 «°TYI1€Z8« ;ec QE€t1«-TEY_KZ
?2}8TA "EUELTOUA&T"8-8«°TYKIrM Q:K"E€d "8-4«°iY "EU

£TOU&T2s [ArO%

m3p
§TA "EUELTOUAT"8-8«°TYMes_c bm8ptT /eKrM

«,ME 1 [Start] > [Programs] > [Cisco Security Mager] > [Uninstall Cisco Security Managet4E ¥ Kr M

1C>Y%[c MMZb"EUELTOUA@"&-8«°TYIErM
«,ME 2 "&4-8«°TU_|WZ MmZb"EUL£I©OUA@P7VIErM
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> @>' "8-4«°TYp_3U7@%$OKS cec "8-84«°TYphb§TA7E
>&8P.A-8' >|g b URL _6+ Installing and Getting Staed With CiscoWorks LAN
Management Solution 3.b  Troubleshooting and FAQ&'v t g!-KZCTI8
http://www.cisco.com/en/US/products/ssstowork/ps3996/prod_installation_guides_list.
html
«,nE UET°c28r[c6~rO0F@ "4-8«°TY<c8TATUET°KZ §1TAVbbaco°

U 38°0U\ /e pbER-«@WITbi-&«°TY 4:)MgA _"e|: M+G\tNaK

rm

Common Servicest utMm zZb  Cisco Security Management Suite U£TOUA&t"84 -8«

°TYMe ebs>8

a. NMSROOT@gWZzZ8+ cec Q€TP7V & - rScijSTSfKrM NMSROOTc
Security Manager8«°TY  tepi°UlbA«[M NMSROOTb1C>Y ic
C:\Program Files\CSCOpx [M E:\Program Files\CSCOpx *]bQbUbivQ#Y[ArM

b. C\CMFLOCK.TXT C“-Y@N~M+ cec Q€tP7VKIM

c. "EUELTOUA&tTI-4«°TYM+S_ b2«°U §lex TQ#YKZ bba«oU
$4°UtP7VKIM

+ My Compute\HKEY_LOCAL_MACHINE\SOFWARE\Wow6432Node\Cisco\Resource Manager

* My Compute\HKEY_LOCAL_MACHINE\SOFTWARE\Wov$432Node\Cisco\MDC

"EUETOUA&T"8-8«°TYM+S _ Windows Defenderf t+-TEY_KS cec GG
[ VIM@—¢TEY_KrM

"EUETOU&b2"4¢hbi»

Security Manager EU£1©U&teSbUUT«_2"4¢PT»KZ Gb0 UUI«[8

BKS0; t—aMeG\c[ArOf GbUUi«b Security Managert Q#Y K8 ,c G
€t"8-4&«°1YK 20[~,8A712U40b0 t1-8«°TYKrM>&G€c 20["~U-
-4«\,8A12U8b-4«°1Y OLe" @ "WZ8G\@SF[M> Qb<] §TA
11+ ET«b¥ - >8P.5-12"' 0°3UI1€Z8+|:_ 2 4¢bi»I€SAT2U4beésSh

—8«°TY[-NKS20["171+ET«bApi"uETY-[ArM

Security Managert2"a¢pbi»M+ cec Auto Update Server 1-8«°7YMe Security
Managerb AT2U&[§11°1€+A12U4 _2"4¢P1»M+20[@6~rM

,811+ET«tY-KS o '6#. PIRLA—«b# ~b'"gA\ $KACA*WSLA-«bER

A xiUOT@ur€eet 5@6+G\_@-KZCTI8 S\<d *A-«Vbeeibi

e8¢ ©«,0f1 ,8A1204b Security Manageff c%$ K §11°1€28vb_"pEC¢
Pi»KS~ ,8AT20& cN~K~*28TU©110¢; K Z6AKS~KSe+ 6@6~rM

1+ Ef«\!A-«tTGKC $10+Su_ MmZbo# PIRTA—«btA-« o1
t1é MeG\1@0/KZCTI8 *e/ 3f>&ceibl, «4¢ ©«,0b0207T UUT«
b”UEC¢PI» > [c tA-«T-8E&°U?}P7VK 1@358-KA"E€d"}"8
@6G\_@-KZCTI8 M4Sb[[c celbi, «4c¢ ©«,0b"HEC¢PI»tT—_
"M20[@6° ;ev6~rM>&S\<d ASA "co ™"  JUf« 8.3c"9” # @ 20[][
W)«nOi»[c8§IT°[AAN8SU Q#Y M- Security Manageb AT2U 8 [%$ K §T11°
1€Z820[@ 6 ~r M>' 0o(y _X82Zc User Guide for Cisco Security Managér
Managing the Device Inventoryp'vt g!-KZCTI18
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ec O«,O00#*.. >e8@fOCTI8 rS §TA@8 1C>Y?° 1ot Q#Y M
e|: 0; 1€Z8G\@f?WZ8* cC 81CHYP© HTTP rSc HTTPSIie
bO¢ >8P.6-1G' £b_ TQ#YKZ-8&«°1Y«_11°10¢; KrM

o Shortcuts8+- (S#Yb©U1°+u°TE+8BM+b? Ghalj«, 1OUA_RC-4&

KZ8+MmZb@i- "e"AMYbO©UTOep°t8BMeb? rSc]b@1#Yb
©Ui%eu°v8BK~"8b? GE€_|WZ 1'b [Start] 0% x1_ Cisco Security Manager
Client @2&gl1€«?@6 I1€rM jU-"8°c [Start] > [Programs] > [Cisco

Security Manager Client] > [Cé® Security Manager Client]Sct«j°uEVb”"-¥47?}
2s-[ArM

 Installation locatior8 j U—-"8°1t -4 «°TYM+C>Y2 Ub d_—-8«°TYM?"

IMHA@MNEE€d 1CH>Y°TWEC°ErM 1C>Y°%b dc C:\Program Files\Cisco
Systems[ M
—8«°1Y “e"i»bee&g_ ‘WZ)FleKrM
[Done] TiUuiKZ-8«°TYTHECKS} "83 " -Y« "EUETOUATMi$x _1.
-TEY_KZ8S ®c—¢1EY_"KrM
i0-"8° —8«°iT0_|WZa&alj«,T©UA4Vb Cisco Security Agen@ 6 FI1€28S
eCc —8«°TYbo6¢i_I2s-1€rM STK ©«,0V] Cisco Security Agentt m - [

1e-TEY_KZ8S @c jU-"8°b-8«°TY@OCKZ?2}QET—¢TEY_Me
0[@6~rM

—4«°TY17<FMe-YxU 0; b #.

41i«, TOUA&VD-YxU «0; tSBe+ "0 Xb% 2\ Security Manager U -" 4
°h -8 «°TYT7<FMesSu_-8«°TYe+ 20 Xb0 @N~KrM —-&«°1Yp_e
8Y @$#OKS cec Windows @1 "« &°_"C° ™ "ph-3«°1Y _20[Vo#."l’ @

UZ1€728G\t&1 KZ?} bA&°t*fOKZCTIS

« >&Vindows XP>' Internet Explorer-Y xU ,«1ibtC>Y°%¢ [c §1A?}b-4&«
°TY @17,U0,°b2"&4RT1» @7<Fl€ee+ 6@6~rM Gb ec bOyu
-f12@/2&gl€rM
Internet Explorer cannot download CSMClientSetup.exe from <server >.InternetExplorer
was not able to open this Internet site.The requested site is either unavailable or
cannot be found.Please try again later.

Gbe8Yt0Z6Me«_c  [Start] > [Settings] > [Control Reel] > [Add or Remove Programsf4E
¥Kz?} [Add/Remove Windows Components]i UpiKrM Windows ¥ aii¢a°
et Ted» | [Internet Explorer EnhanceBlecurity Configurationp ™ piTpj «
teC_KZz [Next] tiUpiK [Finish] tiUpiKrMm

o >&Vindows XP SP2¥VKS-YxU ep+r _|WZ bOp-12@/R&g1€se+ 6 @
6~rM
Security Warning Message.The publisher could not be verified.Are you sure you want to
run this software?

GbOp-12@r&g1€S} [Yes] 1iUpiKZ)EFKrM
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Security Manage8TAc 443 b HTTPS\ 1741b HTTP biC>Y° 119t Q#YKrM))E
[9bTIotQ#Y M« |: _ Security Manage8 1At -4«°1YKZ8S wc 8 t=11

Ot Q#YMe|: jU-"8°10¢, Me20[@6~rM Q:KA"E€d jU-"4°\8§TA

TKF[ArOt

i0-"8°b9bit°ot0, Me_c OO’ ~]b, Y«©® §te+tQ#YKZ C:\Program
Files\Cisco Systems\Cist Security Manager Client\jars\client.info C“-Y 1)...7YKrM bO¢,
t38+KZ <port number>b d_e««+0O 1796 «tee KrM

« HTTPS_PORT=port number>
« HTTP_PORT=port number>
GE€}bog ¢ bjU-"8°12s-KS\A_Q#YIErM

-] N [<] =4 ~

abij0-"8°?}"UE¢PT»[A"8

,8AT2U&biU-"8°@-8«°TYI€Z28+ rSc jU-"8°@-8«°1YI€
Z8SG\@6+47j«, TOUAV _ Security Manager, U —"8°t -84« °TYK]|:\K

S cec j0-"40 ~&4«°70_|WZ,K8AT2UA@-4&4«°1YI€«S_,8AT

AU @"&4-4«°TYIErM Could not find main class.Program will exitg : $ U 1 Oou
-12@/28g1€S ec —&4«°T0[jU-"4°T-&«°1Y[ArO%

m3p

Gbes8Yc ©« , O& ,8b2«°U $8°U@gWz8e. e $I#OKrM Gbe8Y 1t0Z6

Me_c bm8pt /eeKrM

[Start] > [Run] t4E¥K Z regedit \>"’SM+G\_|WZ ba«°U §let12s-KrM

bba«°oU YitP7VKrM
HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Mrosoft\Windows\CurrentVersion\Uninst
all\f427e21299b0dd254754c0d2778feec4-837992615
e€Sb-8«°iyY lepioU>&30-c C:\Program Files\Cisco Symns\Cisco Security Manager
Client't PTVKrM

bC>Y2biST3fKrM
C:\Program Files\Common Files¥tallShield\Uniersal\common\Genl

[Start] > [Control Panel} [Add or Remove Programs4E ¥ Kr M Cisco Security Manager Clier@
rT/22g1€28+ cec [Remove] tiUpiKrM Program already removed; do you want to
remove it from the list?2\8: O p-12 @/2&g 1 €S} [Yes] TiUpiKrm

rT Security Manage U—-"8°T1-4«°1Y[A"8 mc C:\Program Files\Common
Files\InstallShieldt«p j°UbiSt3fKZ v:M@0&KZsZCTIS8 —84«°TYpb
i0-"a0°7¢€ >8P.A-10>' vg!-KZCTIS8
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S\A _ Security Managef U—-"8°?2}"uEtiot4#YM+?2]:2@\a}€rM ;U

—"80 TCo ™ pAjaUas ec §TA TCo ™ pATaUAS e\ L_Me20[

@6~rM

20[ATCo~ ™ "HEITOt2"ART»KZA#Y M+2]:?2@\a}€S cec Web E

U""@"HE'1°b2~"&RT»_ _Q#YIErM C“—Y16ACrSc/eMeb? Lej
_—NM+b?@\a}€rM 8N€?beEQUATAE¥[ArM C“—Yble«jlb-N
TAE¥KS ec C“-Yb2 &RT»<_ERCUOT /eKrM>&C“-Y1t2EY U pj

Me? EU""?2}\a}€S\A_ [Run] e E© U A t4E ¥ K r M>'
Ap3b-8«°TYc jU-"8°b-&«°1Y_ Z8+Su Cisco Security Agent S c
—8«°70b2s-Te+ MeSu_—-8«°TYKSQbUb-YxU, -+ TgoT™”21p
8-b-YxU, e "U71°1t0A«>&rSc [Yes] T iUpi>M+20[@6~rM
—4«°1Yb d@\a}€S} (U-"4°@ -8« °TYIE€Z8+C>Y2@4E¥I€Z8
*G\T&1 KZ C“-YtViAM+?]:?@\a}€£S} [Yes to All] T4AE¥KrM

Ajo URL @V“[A"8 rSc KIF@+-0""°KSG\t <+301 Ou-12@r&gI1€S
cec Security Managei U—-"8°1"4-&«°TYKZ?} CPuoOx ¥ETD>EM[ _
AUS@4#Y1€28>'1T-8«°TYM+20[@6~rM 00(y_X8Zc Security Manager
iU-"8°b"8-8«°1Y >8P.6-14' >|g  Security Manager U-"8°b—-8«°1Y

>8P.6-6' Tg!-KZCTIS8

Tl = ~n -} [o]
EUELT©UalbRlR¢-a
§TA "EUEL1TOUAT-8«°1YK Web EU~"10¢ K Security Manager; U —
t-8«°TYKS} "EUELTOUA _RE—A[ArM
+ Security Manager U-"8°t Q#YKS  Security ManageibR ¢ -4  >&.6-1b
e« WebEU""tQ#YKSS§TA "EUETOUA&IbRE-& >8P.6-13

n 2

aO

Security Manager jU-"8°tQ#YKS Security Manager bR ¢
—-a

Security Manager U-"8°c b 5Xb"EULTOU&A@6+-"EUELTOUA «—=T10\
KZ-8«°TYI€rM Configuration Manager Event Viewer >|g Report Manager> " E
UET©@U&c 3Ubm8p E£[&g| € 3Xb%2b8N€?2[9 _2s-[ArM

o\t]b Security Manager «jc  Configuration Manager EU£1© U && Security Manager
i0-"8° "EUEL£TOUA «-71°bM4S>1tQ#YKZ leKrM

Aae Security Managef U—-"4&°t (_g#Y[A«o#*.."I"@UZIES Windows @1~ "+~ &
°TQ#YKZiU-"4° 4Tj«, TO0U8 _RE-&aM+20[@6~rM |~*8"" T Q#Y
KZiU-"8°1i8K|:\KS @c M4Sbu+t @GKCpu+t K"8 ce@6~rM
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m3p

«,HE 1 Configuration Manager Event Viewer Report Manager Health and Performance Monitor S c
Image Managebh 8N€?t2s-KrM >"EU£T©OU&c b 3Xb%2b8N€?[9
_2s-[ArM

» [Start] > [Programs] > [Cisco Security Manager CliertR>b 8 N € ? T4E ¥ M «>'
[Configuration Manager] [Event Viewer] [Report Manager] [Health and Performance
Manager] rSc [Image Manager][R¢—-3a 2-"RB¢ “«a»"@/P&gI€rM

o l«iopE "—-¥a R¢-a 2-"(3¢ Ted» T @IP&YIETM
e >&8NE?L"EUELTOUA&T2s-KS ' [Launch] >&Security Managej U-"8° "EU
£1OU& «—-1°EbUb"EUELETOUAT4E¥M«>' BRe—& 2-"RB¢ “ed»_c
12&g1€r0 £
«,ME 2 Security Manageb R ¢—-4a 2-"R¢ “+&»"[ BC—-aM-8TAD DNS jt°SrSc
4E¥KrM
> @> DNS i[c”C IP"»bP«t°SrSc4E¥Ms\ Internet Explorer #C _>8ZM4Sb
pt+ @ —-WKS\>~_ -8K"8e+ 6@6~rM MmZb Security Managep+ 1 G K
C-810«_c R¢—-4M+87AD DNS jt°SKrM

«,nE 3 Security Managebh @1 j\A«ai»t°SKrM
« WE 4 8TA@KF_ HTTPStQ#Y M+ cec [HTTPS]3™pilpi«@cead ~WZ8+G\1t&

1 KrM HTTPStTQ#YK~8 cec Qb3™pjTpj«teC_KrM [Login] TiUp;
KrM

«,ME 5 8§TA?}ijU-"4c° TCoT™r "UE!T°h27aRI»\ -4« °TY@O[OI€S @
c jU-"8°bApzac >8P.6-1%' tg!-KZCTIS8

«,pE 6 °SKS@i j{\A«ai»[lepb-poUad@"8 cec jU-"4° "EUEL£TOUA&
>&onfiguration Manager Event Viewer Report Manager Health and Performance MonitorS c
Image Manager @ 8TA_R¢—-&4Kz jU-"4° —4+TC™M_«1tBAATIM

«,ME 7 °SKS@i1 j\A«ai»[lepb-poU&d@M[_N~Me+ cec aNb”"EU£TOU
4?} M-HOUA&[,K8"EUELTOUAT(F"_ 25 [A*%2@6*G\T%t}0O~_
Ou-12@P&GIErM Qb%2\c b\>~[M

>&8NE?L"EUETOUA&T2s-KS > [Launch] >&Security Manager; U-"4° "EU
£10U& «—-T°ZEbUb"EUELTOUATAE¥M >
«,ME 8 K8'EUf£ToU8@uoNb-p©UA&?}2s-1€+? M[_/ep”}dQb”EUET
OUa@C ie«"gA_~~rM

Ad° 0-"4c°c 120 (66" —» Y'gA @)F C\+- -$x _BALIM "—»Y +-0""°13
fMe_c [Tools] > [Security Manager Administrationf4E¥KZ % ?} [Customize
Desktop] T4AE¥K 20[*+-0""°1686t°SKrM Gbp+ t1«-TEY_KZ
iU-—"a°@+--$x _6AL"8|:_M+G\V[AIM

«,ME 9 Security Managerf) ¢tMe+ cec [File] > [Exit] T4AE¥ KM
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CiscoWorks >|g Auto Update Serveb § TA'6# py+ Tuu QbUMmMZb"EUELTOUA
c WebEU " E[I«°1€rM

GEID"EUELIOU&AIDRE-8%2C L[M 17b§TAV 0 Xb"EUETOUAT
—8«°TYKS ec —-4«°TYKSMmMZb"EUEL£T©OUA_ 1 _R¢-&KrM GE€
c BR¢-&@ CiscoWorks_|WZD3I€ G€}b"EUETOU&cMmMZ

CiscoWorksb D
SWI[i«°l€+Su[M

m3p

«,ME 1 WebEU""[ b8N€?b URL t6aAArM serverc §8TA "EUELTOU&A@-4&«°i
YI€Z8+¥&a/Ex12b{S[M 8NE?2b-YxU e "0t°  Te&»T[ [Yes] 1
UpiKrm

« SSLTQ#YKZ878 ®c http://serverl741 t6aArM
e SSLTQ#YKZ8+ mcC http://lserver443 164 ArM

Cisco Security Management SuiteR ¢ — 8#i8 @/2&g1€rM 112V | JavaScript\ cookie
@—-¢TEY_"WZ8+G\\ §11°1€28+A12U4&b WebEU™"t /eeKZ8+G

\tf&1 KrM "EUELTOUAT /eMe|: _EU""10¢ Me%2_ X8Zc Web EU
~ j0="8°bo; >8P.6->' tg!-KZCTI8

«,uME 2 @17 j\A«ai»TQ#YKZ Cisco Security Management SuigsiA_R¢—-&4KrM 6u
Z8TAt-4«°TYMe cec @1 ib admin \0 b-8«°7Yp_ *OlI€SA«
aT» T Q#YKZBRC—&[ATM

«,ulE 3 Cisco Security Management Suitel 1O 172 §TAV_—8«°1YIESu+ _"j-«
[ArM GbiiOl12_¢c —&«°TYI€Z8evb_ |WZ$ "+80% THU*G\@ |
ArM

leM+"EUETOU&>& Auto Update Server "> _PAM+A;YTiUpjKrMm

« [Server Administration]A ¢ YtiUpiKz CiscoWorks Common Service$TA O % x1+t

6aArM GbU&ijtiUpiMed Common ServicesEbd—-b d_&&-[ArM
CiscoWorks Common Services §TAtT6#. M«6% CO°"™”"[M Gb Co~™"+
Q#YKZ §TAb-0\PUEYOx7 *8a¢xRTeY i *O"]bApida»

§1TAu+ 10, KZ'6#. KrM

« [CiscoWorks]U & i>&112b*V>'t1ijUuiKz 81AV]

CiscoWorksiTO 112 t64a
ArM

« [Cisco Security Manager Client Installet]j U pj K Z Security Manager, U-"8°1 -4

«°TYKrM GbijU-"4&°c Security Managel8 TAT Q#YM+SubO-a -4
+TC™M—-«[M
«,JE 4 "EUETOUAT) ¢Me_c #8 'V_6- [Logout] TiUpiKrM 10172\
Security Manageri U-"4°bg% t 1_648Z8« cec EU""KFT) ¢KZv Security

ManageriU-"4°@) ¢KrO %
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Security Manager U-"8°1t"8-8«°1YMe+ cec [Start] > [Programs] > [Cisco

Security Manager Client] > [UninslleCisco Security Manager Clientf4E¥KZ "8-&«°1Y
“e"i»bae&y_‘8rM
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CSRegistryServer
DCRServer
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LicenseServer
Proxy
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©« , O#Y\QbUDER-«#Y _Q#Y[ATr

[ oL-26559-01-J

Cisco Security Manager 4.3 -&«°pTOUA& z-» N



" TV —8«°iY<b§TA +«j

| MRF t Q#Y K S Security Manager ER-«bATE  §—-b0g
[] ~ ~ [] ]
¥aCe xP1OUa ¥bPa»
MRF [c 1 Xb¥DP&»\M4 bSE¥Da&»@fjl€ Security Manage8TA ER-«b
ATE 8§—-bl sv~x3f_Q#YI€rM >ER-«bq >|gq+ATE §—-c mirf

¥DAaA»TQ#YKZO:, [ArM b|:_Gb¥Da»t /eMs\ Gh¥Da»hQ#Y % 2 _
60Me_ @/2&gI€rM

> mrf
mrf help
Prints this message.
mrf backup
Backup existing configuration
mrf revert
Restores backed up configuration
mrf set_heap_params process X-Y [min],[max]
Sets minimum and maximum heap sizes
process -> process hame
X-Y -> Memory Range in MB to which heap sizes apply
[min],[max] -> minimum and maximum heap sizes in MB. These are optional but
atleast one should be specified.
mrf get_heap_params process [memory]
Prints minimum and maximum heap sizes in MB
process -> process hame
[memory] -> memory size in MB for which heap sizes are to be printed. If not
specified heap sizes are to be printed for current system memory.

mrf ¥PD&»t /eMe7ec W "ER-«jbstTQ#YKZCTI8 I* "ER-«jtTa K
Zv $U017c$i#OKrOt w "ER-«jcC 2 7-2 &1€Z28rM ER-«jc+xeD)\
‘eD@ 91€rM

ER-« _PM<ATE § — - b0g¢,

Security ManagelE R -« _PM<ATE §--b0; ¢ bzO[~ 3 Xbm8p[SBI€rM
1.aNbos; b-N

2.aNbos, bl sv~

3.0¢ bsf

1.aNb0; b-N

ER-«bATE §--Db0; c Security Managebh AC>T1D & «_s8jMee+ 6 b6e50]
"m8p[6+Su "EUETOUA&DbS6U bae&gbW[bs «<M«G\tTNaAKrM

rS £75P*(\KZ ER-«baNbOOUO; t5fMeS_ Q€}t-NKZ>CG\vN
AKrM MRF[c 2'8®b-N%2@#Y—-1€Z28rM

1. 1 X% b%2c 0¢ 3ft,«°Me @ _Q#Y[ArM Gb e &M 2 Xb¥ba»
TQ#YKZ QERE ,80, T-NM+eG\ >|g,K85ft,80,¢ _"MG\@I[A
rm

mrf backup

mrf revert

2. 2 X% b%2c ,K80; tTKA}CQ#YKS«<_ ,80 "M @ _zgUrM G€£ c
2Xb%2@6~ b:UbBNE€E?2M% TQ#Y[ArM

Cisco Security Manager 4.3 -&«°pioU4 Z—»
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MRF T Q#Y K S Security Manager ER-«bATE  §--b0g ||

a. 0¢ §ft/leWS«<_ mrfbackupt /eKZ8"E€d mrf revert t /e [Ar M

b. Cisco Security ManageB TAbApu;”"uEtvWZ?} 0, $ft/e8rM Sft—
_"M\VAC AP{"HETY—-KrM Gb ¢ Auij’pE< Jef€StT+b3
fc»f€rM

2. aNb0; bl sv~

17+b-N@0¢KrKSb[ b¥DAa»TQ#YKZ ER-«baNbite8oefO+G\
@[ArM
mrf get_heap_params[process hame[memory]

Gb¥DP&»[ memoryite KAEE€d# ~b RAM §—-@ Q#Y 1€rM M+4 _66°@ 6+
bc#~b RAM §-—-_PM+_[M AUOTz [process nameJc /2 7-2 _&glI€Z 8-«
ib8N€?_"~rM ER-«jcteP\'eD@ 91€rM

Gb¥ba»b Sc bl|: /2&gl€rM Ib")c MB [M

Minimum Heap Size = 1024
Maximum Heap Size = 2048

3.0¢ bsf
#~b0¢; t&1 KS< Gb8o 0°3UI€S1 A ‘WZ0;, T8fM<G\@[ArM
ATE §--10¢ Me _c b¥DAa»TQ#YKIM
mrf set_heap_paramgprocess name[X-Y] [min] ,[max]

AUO1+ [processnamelc /2 7-2 &gI€Z8*ER-«h8NE€?_M+G\@[ArM E
B-«jcxebD\'eDb@ 91€rM

Gb¥Pa»t /eKS« Security Manage8TA t12s-KZ&ftoll0+20[@6~rM

>@>' mrf set_heap_paramst Q#Y K Z/ee f €S3fc ATE AUOT+b&fS_V}ESApui"u
E@Y-1€+\ »f€eet 6@6~rM Gb & ,K8IT-aM+20[@6+\AcC
bm8pt /le[ArM

1. mrfbackupt /eeKrM

2. "EUETOUA&DY-1/e8rM

3. mrfrevertt /e KrM

Gbh¥bPa»[c bSe@Q#YIErM

mrf set_heap_paramgprocess name] [X-Y] [min],[max]

q >|gq+ATE §--10; KrM
[X-Y]>8 ATE 8§—-14#YM+OOU( V>&")c MB>'
[min],[max]>8q ~>|gq+ATE §-—>&")c MB>GE€}ceEOUA[M@ a~C\v 1

Xce M«20{@6~rM

AUO1+ [processnamelc /2 7-2 _&gl1€Z8«ib8N€?_"~~rM ER-«jc+eD
\'eD@ 91€rM

Cisco Security Manager 4.3 -&«°pTOUA& Z—»
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| MRF t Q#Y K S Security Manager ER-«bATE  §—-b0g

0; 3fb[

0¢ Sfb&1

ER-« PM

1" @ATE

©vUoel

©1/4UCEZ

ATE §—-D0b0; Sfb[T&YKTIM

» mrf set_heap_params Tomcat 7372-8192 2048,4096
RAM §-—-@ 7372> 8192 MBb( V/AEDb\Ab TomcatER-«_PKZqg >|gq+Ai
E §--1TQ€RE 2048 MB\ 4096 MB _0;, KrM

 mrf set_heap_params Tomcat 7372-8192 2048
RAM §--@ 7372> 8192MBb( VAb\Ab TomcatER-«_PKZq ATE §—-1
2048 MB _0¢, KrM

« mrf set_heap_params Tomcat 7372-8192,4096
RAM § -- @ 7372> 8192MBb( VAb\Ab TomcatER-«_ PKZq+A{E §_-1
4096 MB _0¢, KrM

 mrf set_heap_params Tomcat 8080-8080 2048,4096

RAM §--@ 8080 MB\Ab TomcatER-«_PKZq >|gqzAiE §--1TQE€R

€ 2048 MB\ 4096 MB _0¢ KrM getramsize ¥P&» 1 /eM+\ alb RAM § -~
Tt MB ")[V“[ArM

ATE AUOT+£10¢ KS« mrf get_heap_params¥Da»t /e KZ5ft&1 [ArM

«ATE §—-b0; bO[(U

GGI[1L AKS Security ManageER-«_PM<ATE §--b0, bSub 3 XbzO[m8pc
b|:_0[(UI€rM GE€}b¥ba»c /e8p[&gl€Z8rM

mrf backup

mrf get_heap_params process

mrf set_heap_params Tomcat 7372-8192 2048,4096
mrf revert #if required to revert changes

§—-Dbl0¢g t20[\MeM+a$x " © ¥4 U ce

6+ Security Manager4.®@1"@ Apisa» ER-«>& VmsBackendServet_ PKZ 4 GBb
qg+xATE 8§--TQ#YKZ8rM G€c 8 GB RAM _ P KZ Security Manager 4.Im~\Z
}J€+1C>Y°bq+ATE §--[6+ 3GB12x<Z8rM Gbo¥%U®b@i"c Apj

$4» ER-«bATE 8§8--1 4GB _I10;, M+20[@6~rM —E3°6#>& Event ServerE

R - «>& VmsEventServer 1 Q#Y>' @ - ¢TEY_~WZ82"E€d Q:M+G\@[ArM

Security Manager@0;, S#Y OT»[Q#YI1€Z8rM>&—E&%6#.\b11°@t+-1EY _
AWZ8e> GbOWUc[c Apijsé» ER-«\ TomcatbATE §--1QxMG\@ |
ArM

Cisco Security Manager 4.3 -&«°pioU4 Z—»
OL-26559-01-J



| " 7v  —8«°iY<b§iA tai

#leb§TA -YxU,e_B6MeE«?® EQj, e«

©% U3
Security Manager@0; S#Y OT»[Q#YI1€Z>~>&—E&%6#.\b11°@L+-TEY _
AWZBe> —E&%#.T—¢1EY_M+20[@6~rM GbO©%Uce[c MmZb
Security ManagelE R -«bATE §—--be0E@8TA[Q#Y+ » RAM §—-12x<"8]:
_Apijsa» ER-«\ TomcatbATE §--106}KZ?} —E&%6# t-¢1EY_
Me20[@6~rM
©vsU 4
—Eaoo#. \Apisa» ER-«c OOUt+5 "2 M+Su |~"Chb RAM m~\Z
T20[\KrM >&-E&°6# @ Q#Y €78 cec Qb (b RAM @Auis8» ER-«_m
~\Z}€e|:_ Apisé» ER-«bqgq+ATE §—-1TQXMG\@[ArM>'
' A P an (1] ~ [ 1] V4 N .
#/eb8TA -YxU, 60MeE «° EUj,*«
©«,0bgq7Hb-Yx" ¥811¢68° |WZO©«,0b626@ *O1€rM Wh3™yp
iU« Eb«,pEc Security Managetb -4 «°iY<b§TA\Qb OSb-YxU, +-1n
_zguUrM
\/ T «j
1. 8TA -YxU,t i$x_O0%+KrM ©«,0 "j A «10°6 KZ&1 KrM Microsoft
Security Configuration Tool Se#MSCTS>'x Fport ~*]1b-Yx U 1iYTQ#YKZ §TAb-YxU
L0 T F$x_&1 KrM Security Manager8TAV _—8«°TYI€S«xa»"R4& Aiaya

b Cisco Security Agent66M+R¢ C“-Y1&1 KrM
A&° MSCTS ¢ Microsoft b Web §-°2} Fport c Foundstone/McAfeeh Web §-°?}°m[ArM

2. 8TAIb'@#"j-«tD7THKIM §TA_V~¥Ket AO1e” »U-E@K)FI€Z28+ ec
Ai» »0-E?)}2s Me|:_8§TAT0, KrM 1L1?2@v~¥Ket A"OQle” »U-E?}87A
t2s-KS @ _ 11+@u I€+>Q€E@6~rM 30-¢c ©«, O BIOS /E [2s -8p110¢ [Ar
M BIOS @IS "A«&i»[-181€Z8+G\1&1 KrM

3. UO1° "j-« TTYXUOTo6# 71YT8TAV_-8«°TYK~AB[CTIS Gb|:"qi
Yc §1AIbs&°U I—8°tfjMe-YxU e U«j_~~rM

4, §TAV[+~ $x2X)E)F$x _-8Me|:_"-Y« «Y0A& "EULTOUA&TO, KrM —Y« o«

YO& "EUELT©OU&cC °R-bE9I?"EUELTOUADETAIDU°T7<F[ATM ~ =Y «*+j
T 1$x_f,KrM

5. 8TA 11+tEf«18-)%_Api"pEKrM MMZbAP{"UET" |-« @DTHIE€S-Yx""
d_—6KrM

—4«°TYrSc’pE¢Pi»b&1

Common Servicest Q#Y KZ Security Manageh -4 «°TYrSc"pyE¢bPi» @B EKS?

1:?21t&1 [ArM Security Manager-4+TC ™ -« @/2&g1€78 rSc GKC/2&gl
€r8G\@NI[-&4«°TYT&1 M+ mcC —8«9%TY<b§TATE >8P.A-5>' 1 gl.
KZCTIS8
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| 684 _

«,JE 1 jU-"4° ©«,OVbEU""TQ#YKZ bBNE?TQ#YKZS8- Security Manages§ 1
A R¢t-8KrM
e HTTP §1A«b e>8 http://<server_name:1741
« SSL §1A«b e>8 https://<server_name:443
§11°1€Z8+EU"\EU""bAT2U&T&1 M+ _c¢ iU-"a°b0[ 6 >&P.3-8'
tgl.KZCTI8

«,ME 2 [Cisco Security Management Suité] 2 [ [Server Administration]A ¢ YtiUuiKZz
Common Serviced [Server] > [Admin] 172164 ArM

«,pE 3 [Process Management]i2 t/2&gMe«_c [Processeslf jUpiKrM
Y YbU«® ¢ MmZb§TA ER-«bjS\ER-«H\b-8«,Tx«bl A@/2&g|
€rM DER-«@G-_-8KZ8+20[@6~rM
* vmsDbEngine
» vmsDbMonitor
« EDS
—84«°TYI€S"EUELETOUA[UDER-«@20[?]:?1&1 M+ _c Cisco.comV _
6*Qb"EUELETOUAE 66M+D¥%x"Ytgl.KZCTI8 0 D¥%x"YDb URL _X82z

604

c biiatgl-KzCTIS8

e« Common Serviced D% x"Y >&P.xiii>'

80% PA

O« b#.0Z Security Managert2s - M «\/2&g 1 €+ P03 g'b JumpStartz-»tgl-KZCT
18

0 b3s3y™ > eldU-4a EYEb Getting Started with Security Manager/E uitg!-Me?
User Guide for Cisco Security Manages™ 1'vtg!-KZCTI8

0 06 b « ecal-3a EYEb Completing the Initial Security Manager Configuration&E y j
tgl-Me? User Guide for Cisco Security Managér™ 1'vtg!-KZCTI8

@1 b1OE\1 «b'6#. b80otgl-KZCTI8
e @1°b'7H >&P.8-3>'
» Security Manageh Cisco Secure ACH)+ e >&.8-12'

1A-«bET® ecal-4a EYED

Preparing Devices for ManagemeftE it g!-Me?
http://www.cisco.com/en/US/produdps6498/products_es_guide_list.html? } °m
+ N User Guide for Cisco Security Manager 418° 2'vtg!-KZCTI8
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@1 "+"4°DG# _c "+ 4°b8B\@I b TH@UI€rM
e "¢"3°p8B >8P.8->' "+7a° ¢ Security Manager ServesRisY "+~ 4°
CiscoWorks Common Service$iAb ACS "+~8° rSc Common Service$ 1A b8

ACS "«"a°@6~rM
e @1"b’'7TH >8P.8-3' '"TH>&rSc"l’>'c /e fOA«l€e+t«j[M '7THc

Security ManagerEb @i” RIY_|WZ *O1€rM Security ManagerE b R1Y ¢
@1 i\A«&ai»bl0E« _0; I€rM 10Ec R¢—&p _ Security Manager_| W
Zle f€rM

"e"a°bh8B

Cisco Security Managet Q#YMs_c¢ —4«°TYp_8BKS admin "+~ 8°T Q#YKZR
¢C—8KZ >@B1"b”"+"4°18BM+20[@6~rM bxz—Eb"«"4°t8B[ATr
M

e RBisY "eT 3o >&P.8-1'
« ACS"e«73° >8P.8-2'
« 8 ACS"+"4° >&8P.8-2'

ngr é o
RieY "e8°c CiscoWorks Common Servic&&?/} [crC Security Manageg T A [
*Ol€rM G€c Security Manage@TA_[w[M bA«_‘8rM
Security Manager@ — a4 «°1YI€Z8«8TA >
Configuration Manager EUE£T©U &b« j°puE "_¥8 >
admin "e~34° Re-& >
[Tools] >

[Security Manager Administration] >
[Server Security] >

[Local User Setup] >

[Add]
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Ago

ACS "+7a°

RTeY 7e"8°c CiscoWorksRieY R¢—-8& OaxiIYTQ#YKrM STK
CiscoWorks—a+TC ™ —«[c~C Security Manage@ i1~ —-4z1C™_—« T Q#YKZi8K
rm
ACS "+~ 4°¢c Security Manage8TA[c/C CiscoWorks Common Service$iA[ *O
l€rM >8&q6cA}?[c”"8G\v6~rM@ Security Manager_ ¢ Common ServicesE b
Server Security Toolg§%& «2s -M+Subl+3 @ 6 ~r M>' bA«_‘8rM

Security Manager® -4 «°TY1€Z8+§71A >

Configuration Manager EUEL£T©U&btl«j°pnE "—-¥4 >

@it "e"&° Re-& >

[Tools] >

[Security Manager Administration] >
[Server Security] >

[AAA Setup]l>& GbT+4&c Common ServicedE b Server Security Tool§%& «2s - Kr M>' >
[ACS]

Ado

8 ACS "~

ACS "+~ 4°¢c >&1>'ACS +—Eb AAA Mode Setup& G € ¢ [Authentication Mode Setupl] i
a_g~rM> >|g>& 2> CiscoWorks Common Servicas ACS R3¢ -8 O2xTYTQ#YKr

M STK ACSR¢-& O2xiYT4E¥M+20[c6~rOFf G€c ACS +—Eb [AAA
Mode Setup]t4E¥ M e\+- -$x _4E¥1€rM

é o
8 ACS "+~ é~° c Security Manage8TA[c”C CiscoWorks Common Service$TA [
*Ol€rM bA«_*8rM

Security Manager@ — &4 «°1YI€Z8+«8TA >

Configuration Manage! EU£1©U&bl«°puE "_¥8 >

@iT "e"ac Re—-a >

[Tools] >

[Security Manager Administration] >
[Server Security] >

[AAA Setup] >

[Local RBAC] >

Cisco Security Manager 4.3 -&«°pioU4 Z—»
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@i°b'7TH ||

Ajo 8 ACS"+"a°c >&1>'Local RBAC + —Eb AAA Mode Setup& G € ¢ [Authentication Mode
Setup]iia_6~rM>' >|g>& 2>'CiscoWorks Common Services bR¢-& O2axiYhb
8N€?1tQ#YKrM  CiscoWorks Locat&1C>Y°bR ¢ -4 Oaxivy>'" IBM SecureWay
Directory KerberosLogin Local NT System MS Active Directory Netscape Directory RADIUS
rSc TACACS+

A us

D1 b’7H
Cisco Security Manage@ R¢-8S_@1 j\A«aT»t10EKrM GE}@10EI£€-
\  Security Manage@ "EUE£TOU&ADbBT" RIY10, KrM GbRIY_|WZ
/e @1 1€+ «jrSci8b-p°[6«'7H>&"I’\v¢gd€>'@ *O1€rM "l bz
«irSctA—«_PKZ1 +I€2A?2WS oc 684 MeO¥%x180% % Ab8% >|g
123@8/28grScle-TEY_~~rM «<Z 4E¥KS _ 1P&KS~ 4E¥KSi8+%
/eKS~MeSub'7TH@ "8G\t <+ Op-12@/2&g1€rM

Security Managem1 0E\1 ¢ CiscoWorks§ 1A\  Cisco Secure Access Control SeprgiCS>'
bJU}? _|WZO6# 1€rM 1C>Y°] CiscoWorksc 1 0E\L « t'6#. KrM @
CiscoWorks Common Serviceas [AAA Mode Setup]iia t Q#Y KZ Cisco Secure ACS 3f[A
rM ACS)+o0eb0d(y_X8Zc Gbvb b80tgl-KZCTIS8

» Security Manageh Cisco Secure ACH)+ e >&P.8-12'
« Security Manageh ACS b%& «8#Yb°UEY©x1,«4¢ >8P.8-29%"

Security Manager 4.3~vS  Cisco Secure ACS Q#YM+50[~OUp°c SIS fATH - p
>&"l bTU®©T +—EbO; TET@T" OAeMe 2 ]>'TQH#YKZ8 — (+ @ b9x 8

@1° BIYT8B[A+G\\ >8> ¢ HOAT| 1A-« ¢YTE>& NDG> 10, Ms+G\ _
IWZ"l btA-«_ @7 tD7IH[A*G\[KS Gb]|:"(+ D b9x8"'>& "a$x " R1

YEl« ”"j-« ¥8°R1Y >8RBAC>>'c Cisco Secure ACS Q#YKZ8287H~ Security
Manager 4.26 SbAT2aU&[c<#Y[ArOt[KS Security Manager 4.3c  ACS Tt Q#Y O
N_RTeY RBAC t<#Y[A+ Common Services 4.0 Q4#YM+Su Gb|:"(- @ b9x 8"l
>8RBAC>' T <#Y [ArM

Security Manager 4.3c  ACS 4.2\b«nd @)Tal€zZ8rM Security Managen Cisco
Secure ACSh)+ e >&8P.8-12' 1 g!-KZCTI8

>& @> RBAC p+ t ACS ?} Common Services &&/e KS8@1 ¢ m-[/ce:20[@ 6 ~r M &&lce
«jUE°v Ub&&/e§ii°v6~rOt

Ajo Security Manager7HfU1Tb2/t/2&g M+ _c Cisco Secure ACS R¢—-aKz?} %A
af©@U& A1b [Shared Profile Components]j UpiKrM 00(y_X8Zc Cisco Secure
ACS RiYbe«tD—= >8P.8-1>' tg!-KZCTI8

beEui[] @17'7TH_X8Z1 AKrM

* Security Manager ACS7H >&P.8-4'

+ CiscoWorksRiY_X82Z >&P.8-6

o Cisco Secure ACRTY _X8Z >&.8-9

« Security ManagerE b '7TH\RTYb1C>Y°h664 UE >&P.8-1b'
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| @i b'7H

Security Manager ACS '7H

Cisco Security Managec*C>Y°b  ACSRIY\V'7THTfjKrM tC>Ye© RTYte«z
D--M+sG\v %i-_ef0OZ38+bRIYT8BM«G\V[ArM STK ,K8RI1Y
t *OMe+ 0@ rSc tC>YP© RiYte«tD-—-Me+ cec dE¥KS'TH@ Security

Manager"EUETOU&DO{II?}4:)[6G\1&1 KZCTI8 S\<d 2&g'7TH t
fA88FTHTUZKS @ Qb@T ' c’EUELETOUATQ#Y[AACA~TM

Security Manager7Hc be,!U_(8®I€rM § b'7TH_66M-1 A_X8Zc Cisco
Secure ACS )+ 1€28+040-4 EYEtgl-KZCTI8>& '7THb/2&g %2 X8Zc
Cisco Secure ACRiTYbe«zh—- >8P.8-1>' 1 g!-KZCTI8>'

o [View]>8# ~Db0¢; bl2&gte+ _KrM z~2&g'7THT _&IKrM
— [View] > [Policiesp8lrJr*+—EbIU©1bR&gts+ KrM GbC>Y2_c

C“-"">1Yx NAT AblrdrrTU©1 iU«b'7TH@ ur€z8rM
— [View] > [Objectsp8lrJrr+—EbiUOT eEa™  opggte+r KrM Gb
C>Y2 _c IUOT eEa™io +_EH\b'7TH@ur€z8rM

— [View] > [Admin]>8Security Manage®#.0¢ b/2&g t«+ _KrM

— [View] > [CLI]>81A-«V[0; I€S CLI ¥P &»b/2&g\ Z64K|:\KZ8<¥D
A»bEPAxTte+r KrM

— [View] > [Config Archive}80;, "T¢—E_-N1€Z28+0;, bMOt/2&gt e+ _KrM
1A-«0¢ x CLI ¥Da»clf&g[ArOt

— [View] > [Devicesp8[Device] AxTEbLA-«\664 _ >&1A-«0; ERA, e
m~\Z/\]>'b/2&gT.+_Kr|\/| NDG TO(, M’G\_lWZ ]'A—«'7HT"|
bi1A-«b-u°_D7H[ATM

— [View] > [Device Managers8Cisco IOSY T+#Y b Cisco Router and Security Device
Manager&8SDM>'"] 6+1A -« S#HYD1A -« D¢120>8&1 sv~S#YATaU &>
b2s - te+ KrM

— [View] > [TopologyP8[Map] A x1[0; 1€SDUEDR&Y T+ _KrM

— [View] > [Event Vieweri8Real Time Viewen Historical Viewerb g % [ Event Viewerb —
E&°bl2&gt++ KrM

— [View] > [Report Manager8Report Manageb b i1°b/2&g t s+ KrM
p g p g
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Manager 4.0.1\  Security Manager 3.34Y _Q#YI€Z8<vb\c9b ACS 1)+ e M+20[@ 6
~rM

aNb Security Manager& «°TYt "uE¢bi»M€E€d L Cisco Secure ACS Q#Y K)F E
G\@[ArM 20[_ALZ '7THO; @f,1€rM

ACS OT»[L0E_»KM-e

Security Manager Sc CiscoWorks Common ServicesB ¢ -4 K |:\KZ)FEZ10E@ » KM
« ;ec Common Servicest Q#Y K Z Cisco Secure ACS1 0OE#Y b AAA §1TA\KZ0¢; KZ8
S\KZv bm8pt /eeKrM

+ ACS §TA\  Common Services Security Managert /oe KZ8+8§1A6& b K)F @&'gl €
Z8+G\1&1 KrM

o Q#YKZ8+@B12(A_>& DT j\A«cai»' @ ACS E[ *O1€Z>~ 4:)"@D1
CYTE _m~\Z}€Z28+G\1&1 KrM
« ACS b [Network Configuration]iia[ Common Serviceg TA@ AAA jU-"4°\KZ
*O1€Z28+G\1&1 KrM Common Servicess{AAA Mode Setup] 172>\ ACS

>&Network Configuration}' [ *O1€S1w&I&YT@ M+ M+G\t&1 KrM

« Common Serviced [AAA Mode Setup]iia[ > ACS §i1Ab IP"»bP«@GKC *O|
€Z8+G\1&1 KrM

ACS b [Administration Control]i12] GK8”«~4°@ *0O1€28+G\t&1 Kr
M

Cisco Security Manager 4.3 -&«°pTOUA& Z—»
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"8V @17 "e"ACbow I
| Security Manager \ ACS b%& «8#Yb°UEY©x1i, «4¢

« Common Serviced [AAA Mode Setup]ita_"j-«KZ Common Serviced Security
Managef& >|g AUS "1bUb-8«°1Yis”"EUETOU&'@ Cisco Secure ACS $i
6 1€28«G\f&1 KrM

« ACS [ [Administration Control] > [Access Setupl&d-KZ ACS @HTTPS30 ™#Y 0, |€
Z8+G\1&1 KrM

e« ACSR¢_ keymismatchs3UT@iA3,r€Z8« ec Security ManagegiA @ ¢ p
AT tA-« C¢YTE>& NDG>bOAAT\KZ *01€28+?]:?21&1 KrM Q
b cec NDG#YbYT@|S_*Ol€28€d QbVYi@ Security Manage8 TA T ut

NDG £DbT btA-«_PKZ *OI€SYT|~Vvf>1€<G\_@-KZCTIS8
NDG#Y_*O1€SYT@ Security Manage8 TAb&I & YI\M+ M+ G\1&1 KrM

1SV~S#Y"j-«@UZIESO«, O6#.*...

CY'7THt aX System AdministratohnKZR ¢ -34aKS_v??f}N Security Managetb M m
ZbTU©T 1712 1 sv~S#Y"i-«K?[A"8 cc Cisco Secure AC§ bms8p t
leeKrM

« >8NDG Tt Q#YKZz8+ > CiscoSecure ACH¥%AnioUa& Aib [Group Setup]tjUup
iKzZ?} System Administrato@1” R1TY @ CiscoWorks\ Cisco Security Manageb g %o

b20[*MmZb NDG>&"l_ Common Services/Security Managéi At ut NDG>' _6564
UE}€Z8+G\1&1 KrM

« Y%AoioU& AiTb [Network Configuration]t jUpuiKz?} bm8pt /eeKrM

— Common Services/Security Managéi A @ Not Assigned&:C>Yo>' ¢ YTE_m~\
Z}€7287"8G\1t&1 KrM

— Common Services/Security Managéf A @ RADIUS [c*C TACACS+ Tt Q#Y M« |
O, 1€Z8+G\t&1 KrM TACACS+c 2 Zb8TAGE[§I1°I€Z8<0M
b-YxU, e ER°¥Y[M

>& @> TACACS+ rSc RADIUS#Y _Security Managefo#. M« ¢ p° i j LA -«
>&YT2 «—U3 C“="">1YA]>'10¢ [ArM

ACS bSf@ Security Manager _2&gl1€"8

Security Manageh Cisco Secure ACS 4.% Q#YKZ8« ec Security Manage8 1AV b

Security Manager Sc CiscoWorks Common ServicesR ¢ —aK S\ A _ ACS?}b_ @
YOu©x1€rM Security Manager R¢—ap_ Cisco Secure AC® [Network Configuration]
\ [Group Setup][§ft+<S c Security Managef Qbsf@ MD _/&gI€"8 r
Sc MD_w _"}"8«+0@6~rM Security Manageh Common Servicesd B¢ "~ °
KZQ€}b"«&»~16aLZ?} IBR¢-A&KZ ACS ?}b_ tUCPUOxM-«20[
@6~rM
ACS [SfTe<e20f@6°+ ®®C BRC""°KZ Security Managef-a»~f6aLZ?}
0 IRC—8M*%2@E«® EUj s«[M

>& @> Cisco Secure ACS 3.8511°1€28r0t@ GbAaU&b ACS t Q#Y KZ 8+ cec

Windows §TA« 16482 Cisco Security Manager Daemon ManaderA « 112s - K ACS b3
ft Security Manager /2&g10+20[ @ 6 ~r M

Cisco Security Manager 4.3 -&«°pioU4 Z—»
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Security Manager \ ACS b%& «84#Yb°UEY©xT, ¢4 ¢ ||

ACS [0¢ 1€StA—«@ Security Manager _/2&gl1€"8

Cisco Secure ACS/ [0, KStA—«@  Security Manager 2&g1€~8 cec 'A—«b/2&g

i :e8YT\IfE€rm

Security Managef *OMe«*A—«b/2&gijc QblA—«7¥ AAA jU-"8°\KZ34+KS
\A_ ACS [0, KSiS\M+ M- 0@6~rM GbG\c"l_ »0-34itQ#Y M-

e _50[[M Security Managef» O -4 jttA-—«j_UeMe+ cecC ACS £bAAA iU
—"&°%bi«ojt <device_name>.<domain_name> M +«20[ @ 6 ~r M>& [>8
pixfirewall.cisco.com'

Cisco Secure ACS @ ?4)Y+ _"WS«<b Security Manager [b8

Cisco Secure ACS@ ?4) Y+ N cec Security Manager n© U4 @ s8jTWErM QbSu

0 Xb Cisco Secure ACETATQ#YM«CriY°°pU&°r"—8CU«°0i30ObS(te
0'M+20[@6~rM 0O Xb8TATQ#YM+G\_|WZ 8N€?b ACS §TADb30 ™ p+ @
»f€ZvV Security ManagerEb 8 T)E)F[ArM

-u°"uE_  Cisco Secure ACS@1 XK?2ur€z>}N ACS @ ?4) Y+ _"WS ce[v
Security Managef{b8 t)E)FMe ec Security Manage8TAV [bRTeY AAA 10E )
~p<*G\@[ArM

m8p
AAA Ot» &fMe _c bm8ptT /eeKrM

«,ME 1 admin CiscoWorksRieY "+~ 4°1Q#YKZ Common Services B¢ —aKrM

«,ME 2 [Server] > [Security] JAAA Mode Setup] T4E¥KZz?} AAA Oi1» 1 Non-ACS/CiscoWorks
Local _3$fKrM G€_|WZ RieY Common Services T+ ET«\Qb) s3, sRTY
TQ#YKZ10E\L 1 /e [ArM RT«Y10ET<#YM+_c AAA 1T+ET«/E _RTe
Y 31"t8BM«20[@6~rM

«,ME 3 [Change]tiUpiKrMm

Cisco Secure ACS Ib”"j-«bY-

Cisco Secure ACS@2"4KSSu_ Security Manager "i-«[A*C~ WS cec bm8p
t l,e KrM

« ACS 8§TAV[ Windows §TA«12s-KZ CSTacacs§ 1A «\ CSRadius§TA« @' >
KZ8+?2]:?21& 1 KrM 20 _ALZ G€}b8&§TA«TI2s-KrM

* CiscoWorks Common Servicgs bm8p T /e KrM

«,ME 1 admin @1"\KZ Common Services B¢ -4KrM

«,ME 2 DOS"+&4»~1648Z NMSROOTbin\perl ResetLoginModule.pl T /e KrM

«,ME 3 Common Services) ¢KZ?} admin @1 \KZI@GREC-A4KrM

«,nE 4 [Server] > [Security] JAAA Mode Setup] _&-KZ?} AAA Oi»t [Non-ACS]> [CW Local]

Of» §fKrM

Cisco Security Manager 4.3 -&«°pTOUA& Z—»
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" 8'v Fi™ "e~4°Db'o#.
| Common Services 4.0 TQ#YKSRTeY RBAC

«,ME 5 Windows §1A« 16482 Cisco Security Manager Daemon ManadetrA « t12s - KrM

tA—«_ :10Ebe8Y

Cisco Secure ACS 33-1€SH Y310

1A-«>&0 Xb
afi —-4+x1C™ -«

Network Interface CarkNIC; ¢ pu°
*i»>'@ /eI€STA-—«> @0¢ [A"8 o2Cc BT RTY_1
A-«b3f'TH@Ur€Z8S\KZv QbtA—-«b IP"»b«b°S%2_:e8Y @3$i#0
Meet 0@6~1rM

DY31O0 tA-«t CiscoSecure ACH AAA jU-"8°\KZ *OM+ cec
IP"»bp«t *OKZCTI8 °SMeSqg_ Enter t2KrM 00(y _X8Zc

NIC H\b
Kr"8tA—«b AAA jU-"8°\KZDb34- >8P.8-1%"' 1 g!-KZCTI8

NDG t Q#Y

NAT CHOb*li< 0,*(1€StA—«_ :10Ebe8Y

Cisco Secure ACS34+1€S NAT SrSc NAT <b IP"»b«taXtA-«1t0;, [A"8

ec @17 RIY_TA-«b3fTH@Ur€Z8S\KZv 0¢ KS IP"»b«_ :e8Y
@$HOMeet 6@6~1M

LA—«@ NAT CHUD*i< _0¢*(1€Z28+ cecC Cisco Secure AC® AAA jU—-"4a°¢ [

tA—«bMmZb IP”"»b«>& NAT S\ NAT <tut>'t *OKZCTIS8 ACS Ib AAA
U-"4°; b33a+%2_ X8Zc User Guide for Cisco Secure Access Control Serivgt- K
ZCTIS8

Common Services 4.0 tQ#YKSRTeY RBAC
Security Manager 4.3~v S

Cisco Secure ACS Q#YM50[*OUp°c >&>"IfA'7H-p
>&"l bTU®©T +—EbO;, TET@T" OAeMe 2 ]>'TQ#YKZ8 — (+ @ b9x 8

@1 RIYT8B[A«G\\ >8> ¢ u°aii 1A—« ¢YTE>& NDG> 10, M+G\ _
IWZ"l btA-«_ @7 tD7IH[A*G\[KS Gb]|:"(+ D b9x8"'>& "a$x " R1

YEl« "j-« ¥8°R1Y >8RBAC>>'c Cisco Secure ACS Q#YKZ8287H~ Security
Manager 4.26 SbATaU&[c<#Y[ArOt[KS Security Manager 4.3c  ACS Tt Q#Y O
N_RTeY RBAC t<#Y[A+ Common Services 4.0 Q4YM+Su Gb|:"( @ b9x 8"l
>8RBAC>' T <#Y [AT M

Security Manager 4.3c  ACS 4.2\b«ndo @)Tal€Z8rM Security Managen Cisco
Secure ACSb)+ e >&8P.8-12' 1 g!-KZCTI8

>& @> RBAC p+ t ACS ?} Common Services &&/e KS8@1 ¢ m-[/ce:20[@ 6 ~r M &&lce
«jUE°vy Ub&&/e§11°v6~rOt

Common Services 4.0c @1 be«zx0 RiIYt*OK @i"baNbRTYTe«wtb-
~MeSubtA-«PEYD RBAC @6~rM bu+ tQ#Y[ArM

@17 b'o#.>8&3a P7V )...7Y>'

e« LA_«PEYDb RBAC tfjMesSub¢puoai;

1A—« ¢ YTE>& NDG>' b'6#.
e o«+0O RTYDb'oH.
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OL-26559-01-3 |



| " 8v  @1" re"acboh
Common Services 40 TQ#YKSRi-Y RBAC M
e @17 C¢YTE TA-« ¢YTEIbRTYbPuAEAC
o G MOAT e Ea™ joprgg §1A« ®Ea™; op&f >|g -« Y1Y
bsf "biU©T cEa™;o +_E\T0O1 +—E_PMe(@Db9x 8"l
b3U"bz«itT6¢MeG\] Common Services 4.0 Q#Y KZRT«Y RBAC 1 /e [A
rm
+ 10EOT»b0¢ >&P.8-33'
e O170#. >8P.8-33
+ CYTE'GH# >8P.8-34
« RIYo#  >&P.8-34
10E O1»hb0¢
bm8pt /eKZ 8 ACS "+«~a°t0¢; KrM 8 ACS”."ac° >8P.8-2' 1 g!-KZC
TI8
[CiscoWorks Local]lR ¢ -84 OaxiYt4E¥KrM
Ago [CiscoWorks Local]lc Security Manageb jU1d —-8«°TYb1C>Y°i[M
D 10#.

Common Serviced [Local User Setuplita_&4i-KrM
Security Manager® -4 «°TY1€Z8+8§1A >
Cisco Security ManagetEU£1©U&bt«j°uE "_¥8 >
@iT "e"ac Re—-a >
[Server Administration] >
[Home] >
[System Tasks] >
[Local User Setup]
[Local User Setup]iia[ @1"t4E¥K b"{©U&DSNE?T4E¥[ArM
¢ Import Users
e Export Users
« Edit
» Delete
» Add
» Modify My Profile
0 Xb@1"t4E¥Me+ @ [Edit] C4AE¥[ATO ¢
BT T4AE¥K"8 cec b”j©U&ADSNE?TAE¥X[ATM
¢ Import Users
» Add

[ oL-26559-01-J
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| Common Services 4.0 TQ#YKSRTeY RBAC

« Modify My Profile

[Edit] rSc [Add] T4E¥Me ®c b 3 Xbl «++—Eb8NE?TAE¥[ATrM
» Full Authorization
» Enable Task Authorization

« Enable Device Authorization

Security Managemb [Device Groups]ii2_&i-KrM
Security Manager@® - & «°1Y1€Z8+8§TA >
Configuration Manager EUE£T©U&bl«j°pnE "_¥8& >
@iw r"eT4c Re—-4a >
[Tools] >
[Security Manager Administration] >
[Device Groups]

Common Services-&+1C ™ —«>& Security Manager® —-&4«°TY1€Z8+81A > Cisco
Security Manager EUE£TO©UA&b1«°pE "_¥A'TQHYKZ 1A -« ¢CYTE t6# M
*G\c[ArO#f

[Role Management Setud]ia _&4-KrM
Security Manager@ — a4 «°1YI€Z8+8TA >
Cisco Security ManageftEU£1©U&bt«i°uE "_¥& >
@iT "e"&°  Re-& >
[Server Administration] >
[Server] »& 0% xT -bjx0°e«>' >
[Security] >
[Single-Server Management] >

[Role Management Setup]

[Role Management Setud]i2 _ctC>Y°bR1Y>& Approver Help Desk Network
Administrator Network Operator Security Administrator Security Approver Super Admin > |
g System Administratet @/2&g1€rM  [Role Management Setud]i2 _c 38+KSe+« 0
RTY>& 6+« 0> v2&gIE€rM

[Role Management]ia[c Add Edit Delete Copy Export Import Set as default>|g
Clear defaultb>78 1 /e [ArM

Cisco Security Manager 4.3 -&«°pioU4 Z—»
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Ca N r d

CUEYOxT,*a¢

CiscoWorks Common Services Security Manager. 8 TAV[b—-&4«°1Y "8-&«°1

Y >|gl-&«°TY#YbCPTOA&T{TfjKrM Security Manager8TA ~co~™”
b-&4«°TYrSc”8-4«°TY[3UT@%$1#OKS cec Common Serviceb e 80U -4
EYEb Troubleshooting and FAQst gI-KZCTI8

b°Epjc «x&d»"RA& Ai2U &b Cisco Security Agentt ut jU-"4° ©«,0
rSc81AV_  Security Manageéd4 ¢o~" ™" "EUL£TOUA&tT-4«°TY "4-8«
°TY rSci—-&4«°TYKS\A $i#OMee+ 6b6+e8Yb0Z6_zgUrM

« Cisco Security Manageg T A « b2s -0[ 6 >&P.A-1>'
e 29[~ TCPI10°\ UDP 11°bRO$x U «© >&P.A-1>'

+ Security Manage81Ab°UEYOxT, +4¢ >&P.A-3>'

« Security Managej U—-"8°b°UEYO©Ox1,4¢ >&8P.A-10>'
e« §1A -YC.«°b e  >&P.A-16>

o 8TA P°UEYOxT ,«&4¢_ bp7VY >8P.A-17'

e 8TA ER-« «,1x«bl2&g\&f >8P.A-18>'

e §8TA -8«°1Y R¢ C“-Yb&1l >8P.A-18

Cisco Security Manager 87A«b2s-0[6

Cisco Security ManagegTA«c "l b8pi[2s-K"E€d Security Manager@ G K C pu+ K
rot G€}b8iA«b6itic Cisco Security Manager Daemon ManaderA « _ |WZ D
S1€rM Cisco Security Manageg 1A «b2s -+ —Ec3fK~8[CTI8 rS Cisco
Security Manage8TA«cm-[8FrSc6a KA8[CTI8 "l b§TA«ti2s-K~

E€d"}"8 cc Cisco Security Manager Daemon Managdei2s - KZ M m Z b6d4 §1A
«@GKB88pI[6F>|g6a M+20[@6~rM

20[~ TCP I7°\ UDP 11°b R O$x U «°

Cisco Security Management SuitE UET©U&c jU-"4a°xUb"EU£L£T©OUA\30™
Me20l@6~rM QbUbSTA "EUL£1©OUAcOb¥aEx1xV_—8«°IVY[ATr
M30™+tBEIO«Su_c"l b TCP11°\ UDPI1i1°1648Z °UCeni3&@™ _Q

Cisco Security Manager 4.3 -&«°pioU4& Z—>»
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M o~ TCPii°\ UDP 11°bBO$xU«®

#Y[Ae|: _M+20[@6~rM 30-c 0[rgTA«\TTO >8P.3-1>' _0°3U1€Z8-
11°t6ACTE[ ([M STK "EU£10U&a@30™Y+ ~"G\té KS cec b/
AbitoveaC20[v6~rM U«°ciio$ «8p jt[8rM

P A1 20[~§TA«\TT0
>
~ 2 " * =
PIRrScQ#Y"EUET iteg« / o -
§TA« ouva iTeb( Vv w 2 ®
FTP Security Managek TMS §1 |21 TCP — | X
A6& b30 ™
SSH Common Services 22 TCP — X
Security Manager 22 TCP — X
Telnet Security Manager 23 TCP — X
SMTP Common Services 25 TCP — X
TACACS+>8ACS b > Common Services 49 TCP — X
TFTP Common Services 69 UDP X X
HTTP Common Services 80 TCP — X
Security Manager TCP — X
SNMP>& 11U & ¢>' Common Services 161 UDP —4 X
Performance Monitor 161 UDP — X
SNMP>&° U p E>' Common Services 162 uDP — X
Performance Monitor 162 UDP X| —
HTTPS-&SSL>' Common Services 443 TCP X |—
Security Manager TCP X| X
AUS TCP X |—
Performance Monitor TCP X| —
Syslod Security Manager 514 UDP X| —
Common Services8Security |514 rSc 49514& G UDP X |—
Manager@ — &4 «°1Y 1€ blee b+. @ t g!->'
2878 >
Performance Monitor 514 UDP X | —
>&Security Manager@ — a «
°TY1€Z2878 >
U1 ¥AET ERC¥Y Common Services 514 TCP Xl X
HTTP Common Services 1741 TCP X —
Security Manager TCP X| —
AUS TCP X |—
Performance Monitor TCP X| —
RADIUS Security Manager& ¥4SAAA |1645 1646 1812 |TCP — | X
LDAP §TAI> >& ,0d>' 389 636
>85SL>' 88
Kerberos
Access Control Server HTTP/HPB Security Manager 2002 TCP —-+ X

Cisco Security Manager 4.3 -&«°pioU4 Z—»
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Security Manager §TAb°UEY©xT,«4¢ ||
P A1 20[~§TA «\TT0° >&)F A>'
>
~ z " H* =
PIRrScQ#Y"EUET ifeg e / o | f
§1A« CHVE:! iteb( Vv w 2 %
CiscoWorkse i°YTA#Y b HIPO |Common Services 8088 TCP X X
iTo
Tomcat© O p°2~ 4§ Common Services 9007 TCP X —
Tomcat Ajpl3¥ ¢ j + Common Services 9009 TCP X —
1T+ ET« Security Manager 10033 TCP X —
License Server Common Services 40401 TCP X —
Daemon Manager Common Services 42340 TCP X X
Osagent Common Services 42342 UDP X
1T+ EfT« Common Services 43441 TCP X —
Sybase Auto Update Server 43451 TCP X X
Performance Monitor 43453 TCP X X
DCR\ OGS Common Services 40050>| 40070 TCP X |—
Event Services Software Service 42350/ UbDP X X
44350
Software Listening 42351/ TCP X | X
44351
Software HTTP 42352/ TCP X X
44352
Software Routing 42353/ TCP X X
44353
3732 O+ 1% - O>&STM>' Common Services 50000>| 50020 TCP X |—

1. Cisco Security Monitoring, Analysis, and Response Syst€isco Security MARS' "EU-"8«\_ tiwrSc°nM+Su
_ Security ManagerctC>Yo[ii° 443 Vb HTTPSTQ#YKIM Gb% $x[9bT1°t Q#Y Me?]:? T4E¥[AT
M

2. Security Manageb -4 «°TYrSc”uE¢PT»1_
rM 6\[ Security Manage@ "84 -4 «°TYI€S o I1°c

Common Services syslo§iA« Ti°@ 514°?} 49514 _3fl€

514 “I1€rOt

V4

Security Manager 8§TAbCPUEYO©OxT7,+4¢

Ghb8o[c b$2e_>A<KrM
o —é«°TYpb§TA7€ >8P.A-3>
e —4«°TY<b&TA7E >8P.A-5>'
.« "&-8«°TYpb§iA7E >&P.A-8>"
[] A A Q2

—a«°TYpbSITA7E

Q. §8TA "C°"™"h_8«°1VY1_/2&GIESGb—-8«°TY §07 Op-1ac]:8
—a[M?
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| Security Manager §TAb°UEY©xT,+4¢

A. TCoT™MTh_g«ofY §07 Op-1a\L At 2 A-28P.A-4' &KrM Gb
l2c>8EbeDPb”YC“En®p_jm}€zZ8rM
P A2 —8«o7Y Op-12>& §1A>'
Message Ou-12b##a gi"18

License file failed. ERROR:
The file with the name
c:\progra~1\CSCOpx\setup
does not exist

> Common Servicek N ”
EUEiOoUAT"8-4«
°TYK|:\KZ»KKrK

S

1. §TAtoOu°2"84KZ?2} 12s-KrM

2. ba«°U 3lexTQ#YKZ b3&°UTP
7VKrM
$HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Ci
sco\Resource Manager\CurrentVersion

3. Security Managert -4 «°iYKStepj©
U[ setup\8:{Sb8§Et«bj°Ut8B
KrM

4. CMFLOCK.TXT tP7VKrM>&N~Me ce>'
5. Security Managert -4 «°TYKrM

Corrupt License file. Please
enter a valid License file.

U--4« C“-Y@wUTtKZz
8¢?2 U—--4« C“-Yb
£ @ [M

U-—-8« _66Mse-| >8P.2-8' 1 gl-KZCTI
8

Corrupt License file entered
for 5 tries. Install will

proceed in EVAL mode. Press
OK to proceed.

5G4 "0--4«
C“-YIbA«jt°SKS

+ 0@6~rM 08le@ 5G
»KKS} —&a«°iY @oU
00i»_&f~rM

[OK] tijUpiKZ U--&« 301
THj«tBALZ "+ "i»b b#8 _4 srM

2_"p¢

One instance of CiscoWorks
Installation is already
running.Ifyou are sure that
no other instances are
running, remove the file
C:\CMFLOCK.TXT.This
installation will now abort.

> Common Servicek N ”
EUELTOUAT-&«°TY
KI'\KZ»KKSe+ 6@
6~rM

CACMFLOCK.TXT C“-YTP7VKZ?} v:M
P0eKZsZCTIS8

Severe

Failed on call to
FilelnsertLine.

§TA@AT» »U-E «
1T«_66M+0[6T6SKZ
8rO%

§TADbO[6>|gNa!'8o
T8

>&.3-3' tgl-KZC

Temporary directory used by
installation has reached
_istmp9x. If _istmp99 is
reached, no more setups can
be run on this computer,
they fail with error -112.

§TAV[ “gco~m> )
«°iYp_+--$x_P7VIE

£ bBMIC“-Y@gWZ
8rM

§TAVbMitebioU[;S_ _istmp eb
4@Ur€e8ELepi°UTHKIM Gb]:
N§Elebi°UtMmMZP7VKIM

Il Cisco Security Manager 4.3 —&«°pioU3a Z—»
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Security Manager §TAb°UEY®©xT7,+4¢ ||
P A2 —8«°TY 30T Op-12&87TA> >&FA>
Message Op-12b##a gii8
Windows cannot find §11°1€2878_v?? 1. Terminal Servicestt+-TEY _KrM
‘C:\Documents and ; ; _
Settings\Administrator\WINDO { } TA YTeI’mI.anll‘ESYervllfeSf Gbm8p_X8Zc b URL _6-
WS\System32\cmd.exe'. Make g«+ . pg— OI\LI - Installing and Getting Started With CiscoWorks
sure you typed the name > © @ : T';A o oTa« LAN Management Solution 3.b  Terminal
;;gif]Ct'Tyé zggrf;ef’:):zﬁle ! Y&‘D 49; I” iU« Server Support for Windows 2000 and
click the Start button, and 8 843 gt KZCTI Windows 2003 Serverr £t gl-KZCTI
then click Search. 8
http://www.cisco.com/etJS/docs/net_mgmt/cisco
works_lan_management_solution/3.1/install/guide/
IGSG31.html
2. Security Managertv:M@ -4 «°TYKZs
ZCTIS8
Setup has detected that —8«°1Yp_  Windows” |1. %WINDIR% _iA3,tSubd)*"7TH@UZ
uninstallShield is in use. TRAOTH@ ™l € 1€Z8+G\1&1 KrM —8«°iVYrS
Close uninstallShield and M Ci Works C " A 8«07V RieVoh+* C¢YIE
restart setup. Error 432. CiscoWorks Common cd-&«°TYc RBieYO#*.. i
Servicest —-a«°TYKZ8 bOAaAT@ <M*20[@6~rM
. i "o~ 80 T .. ~ .
Y‘,’Y;‘EOYYIS,TAJ‘VZ@;% 2 [OK] t1iUpiKzs01  Opu-iateaL
S stallShield. G b & Windows 2 }R ¢ ""0KZ R1sY'5#*.."I
UO?CO nsta ,2|e|_ s TTAX"eTACT QHY K Z Windows _ 1R ¢
i p-T2@2&gl € _AKIM
M
Q. 8TA —-a«°1U@ #.tp>&A&¢"UE>KS ec]:KS}88[M?
A. UEI°KZVv:M@0&KZsZCTIS8
Q. Cisco Security ManageY Cisco Secure Access Control Sernveg %t 1 Xb©«,0OV_-4
«°TY[ArM?
A, —8«°TYK"8G\tNaKrM L&TAVI[b Security Manageh Cisco Secure ACS
for Windows b1 N c§iT°1€28r0O ¢t
Q. Security Managet 1+ ET«bApj"HE@»KMebcrP[M?
A. Tivoli "]b¢peaiiot. "EUETOUATQ#YKZ Security Manager@ — & «°1Y |
£€SO«,0V_ Cygwin t-8«°1YKS e®c Security Managef T+ Ef«b Ay
"WE_»KKrM Cygwin t"8-8«°1YKZCTIS8
[<] A\ A R
—a«°1Y<b8TA7€
Q. Security ManageraziC™ -« @/24g1€78 rSc GKC/2&g|€"8 6+8c "l
b-8+TC™—-«0[(0@ EZ8rM Nlcl[K{:?
A. 8CX?be+ 6@*f<}€rM GbU«°EbO©%Ucetg-KZ —8+71C™—«_s8§

tZ<eet Ob6+"(c"e8Y 11 K P KZCTIS8

0[~8§7A«b8CX?@81AV[-8KZ8rOt §1Abt704
12s-KZ MmZbg§TA«b2s - @6¢Mebt..WZ?}
4°112s -KZKFK%$KZsZCTI8

petadt
Security Manager U -~
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Security Manager §TAb°UEY©xT,+4¢

§TA_ (M5Alex; «1T«@6~r0t §TAVD Security ManagerA 1, »
©U&b5A 5@ 500MBeéV6.G\t&1 KZCTI8

6eU--8« C“-Y@WU1tKZ8rM U—--&« _65Me-]| >8P.2-8' 1 gl-KZ
CTI8

S§TA[Q#Y €278 Windows0+1 @684*WZ8rM (s\,el AT2U&b Windows V
bel \ ¥+1 A72U&b Windows Vb ¥+l K?8T1°1€Z28r0 1>& §1ADb
0[6>|gNal!8o >8P.3-3' T g!-> UbOel c—&«°TYIESAT2aU&b

Security Manager_ Os8jtZ<ee+ 60 @6~rM rS GUIO[(0b - c»+ 0b6

$U'gb 1 X[M 8§17°1€Z28780:1 tQ#YKZ8+ cec §I71°1€Z80¢

1 t4AE¥KZ?}  Security Managerf "8-8«°1YKZI-&4«°TYKZCTIS8

§1A "EU£ToU&b"8-4«°1Y >8P.5-16" T g KZCTIS8
HeAaTiKFV] Security Manager 8 «°TY @1,eU, T /@eKrKkS@ G
bQ#Y % 2c811°1€Z28r0 t>& Security ManagelsTA  Common Services> |

g AUS b-&«°1Y  >8.5-2'tg!l> §1A ~CoO ™" "t"38-8«°1YKZI-
4«°TYM+20[@6~rM §TA "EUETOU&b"&-84«°1Y >8P.5-16"' T
gl-KZCTI8

i0-"84° ©«,0@q 7HbO[6T6SKZ8rO*t i0-"a°b0[ 6 >&P.3-8'
Tgl-KZCTI8

HTTP T Q#YK|:\KrKS@ 20["ER°¥Yc HTTPS [M
Tt38TE@R&GIE€r0O % Security Manager; U —"8°t Q#YKZ8+qp_ jU-

"8° ©«,OV][ [Display Propertiesl¥4°Ri1Y A, VY 1648Z [Appearance]tE [
8CX?b0¢, t3fKSe+ 6@6~rM Gbe8Y P M+ ¢ Security Managef

U-"8°1) ¢KZ?} I2s-KZCTIS8

684*WS¢UCepj« *T»b»0U-A ~Co"™m"@;0-"4° ©«,0V_-8«
°TYI€Z8rM iU-"&°b0[ 6 >8P.3-8' tgl-KZCTI8

e8Y Web EU~"tQ#YKZ Security Managetb Web -8+TC ™ -« 164 G:\KS\A _
Security Manage&TAV b /cwhp/LiaisonServiet_"j-«M+Sub’7H@ "8G\t <« Op
-12@/2&g1€rKS G£€c]:8:-a[M?

“UxfoUa Wbhi2_ Gbe8YbM+a$x NI\fLI€Z8«P 21t&gKrM
7 A-3 LiaisonServlet SUTbNI\P 2

NI P 2

§TAV _"&3" - "837 -V« "EUE£TOUA&T"&4-8«°TYKIM

Y« "EUETOUA
@-8«°TYI€Z

80

§TAV_ IS @-4& |lIS ¢ Security Manageh«né @"8Su "&—-&«°1Y M«20[
«°TYI€Z8. @6~rM
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| U6 A °UEYOxT, -4¢

Security Manager §TAb°UEY®©xT7,+4¢ ||
2 A-3 LiaisonServiet $UTbNI\P 2 >&)F A>'
NI P 2
Security Manager 2 |+--_0; M+20[@6°87A«c Cisco Security Manager Daemon
O["8TA«@GKS ManagerTE[M Ub CiscoWorks§TA«cm.-_0;, M«20[ @ 6
8pi[ea 1€z8~ ~rM Daemon Manage@ U b Ciscoworks§TA «t2s-Mer[_ X
8 (77 2@6+G\_@-KZCTI8 GE€}b8§TA«c GK

88pT[2s-M«20[@6~rM m-[81A«12s-KS cecs
UTt,A2sGMe+ 6@6~rM

casuserA « 41» casuserB¢—ac  Windows'o#.*...\ L[ MmZb Common

Servicest « i\  Security Manager «j_"ji-«[ArM Db]:
_casuserA «ai»tU-poKrM
1. §TAV[¥DAa» ERAE°T6AATM

>& @>' Windows Server 2008 Q#YKZ8+ cec ¥D&» ERAE®
164 C\A _ [Run as administratorfe EOU &1 Q#Y M+20[ @ 6
~rM

2. C:\Program Files\CSCOpx\setup\support\resetCasuser.exe \°S
KZ Entert2KrM

3. eE©UA3& 1>8&asuserBA «4T»bU&20#0B> t4E¥KrM

Security Managert Q#Y KZ81AVbiepjoUtgl-KS\A_ RieY TOxTOT
E@/78g1€ PUEI€S»0U-Ec/l2&gl€r0Ot ]:KZ[M?

Microsoft c§TA -YxU et1iMeSu_ Windows b0¢0£ _Gbpu+ t) s3,srKS
Security Managef4E¥M«20[b6MmZbC“-VY>& U—-- &« C“-=Y~]>'t8TA

V _4AX(M+20[@6~1M
1 ATaU &b Windows b [Start] O % x1_  Security Manager@/2&g 1 €~8bc” P |

aUab Windows &£ b0l \KZ,el c8i71°1€Z8r0 P& §TAbO[6>|gNa

¥

M

§1AVDb..®\01 beeEQUA&T el TQ#YMe|: 0 KSe+t 6@6~rM ¥l
A1t

180 >8&P.3-3>' tg!'>' ¥&°RI1Y A¢YTQHYKZ 0e1 t¥e1 _U-u°KZCTIS8

§TAb SSLOEAi@"“ _~WZ8rM rS DCRServerER-«@6a KrOf Nlc
1[K{:?

§TAb¥UrScil@ SSLOEAibw (V¥_U-p°l€z8rMm —&«°(Y=
"g#3s™MpjU«® >8P.4-3' tgl-KZCTI8 Ghe8Y_P Me_c §1Ab¥U /i

Ib0¢ tU-p°KZCTIS8

§TA\jU-"8°8b30™ Q#YIE+ER°¥Yb°S@0[OI€rOf[KS 1C>Y
C[Q#YIE*ER°¥YCc1[M? UbOT»tQ#YKZGhbO, tm-[§fM+20[@ 6
~rMm?

§TAb-&«°1Yp_j0-"8°1T-8«°TYKS cec 1C>Y°[ §TA\;U
—"8°68b30™ERC¥Y\KZ HTTPS @ Q#YI1€rM 30 ™ctC>YPO ERO¥Y T Q#Y
KZ-0EI€Z8+Su GbO; tm-[§fM+20[c6~rO*%
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U6 A °UEY©OxT,«4¢
| Security Manager §TAb°UEY©xT,+4¢

ER°¥Y\KZ HTTP t4E¥Me+eEO©UA&c §7A -4«°70\c9_ jU-"4°
-—4«°T0t /eKZ Security Manage U-"4°1-8«°TYKS e _bsQ#Y[A
rM STK 8TA\jU-"4°&b30 ™MER°¥Y\KZ HTTP 1t Q#YK~"8G\tNa

KrM jU-"8°c §8TA@Q#YMe|: 0, I€ESERCY¥YTQ#YM+20[@6~r
M

Q. VMware -p°"pETQ#YKZ8+\©«,ObAC>i1DA«@WE°£€}€280]*WK
rM S\<d ©«,ObApj”"nE _ 2i66v??2~rM

A. Security Managerf /eKz8+ VM _0 Xb CPU@mM~\Z}€Z8+G\1&1 KZCTI
8 1XbCPUK?mM~\Z}€287280«,0[c M4Sh©«,O i oA, e PK
ZWE°€}€780]bAC>1PA«T&IMG\@ f?WZ8rM

Q. e0E~]1b8CX?bi8 @

SQL jSUT[¥TR¢_ SKZ»KKrM NIc1[K{
0 ?

A. SybasebMitepi°Uble« 8o @2S~"C"~ MiGC“~Yb8B_»KKSs+

6@6~rM 1C>Y°[c Windows bMitebi°UbW _ SybasebMiC“-Y @ 8
BI€ErM ©«, 6 08X SA TMP @ *O1€28+ cc SA_ TMP & |€StepjO
U MiC“-Y@8BIErMm SybasebMiC“—Y @4A*(1€+1e«i8eatjU”K

Z?} Security Managerf 12s - Kr M

Q. Gb"a-4«°1Yy §01 Op-tacl:8:—-4a[M?
A. "4-4«°1Y $0U7 Op-ta\1 At 2 A-4>8P.A->' &I KrM Gb/2c>8Ebebb
"YC“Eu°8p_jm}€Z8rM "&-&«°iY §07T Op-12b0o(y_X8Zc
Cisco.comV [ Common Services 3. D% x"Ytgl-KZCTI8
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Security Manager §TAb°UEY©xT,«4¢
2 A-4 "84 «°TY §07 Opu-1e
Message Op-12b##a 1778
C:\ NMSROQMDC\msfc-backend GbOp-iac @78+ Ou-121"dKZ"84-8«°TY@»KKS
refers to a location that is +6@6~rM [OK] t; ec bet 6b6+P 2bM%rScg% t0&

unavailable. It could be on a
hard drive on this computer,
or on a network. Check to
make sure that the disk is
properly inserted, or that
you are connected to the
Internet or your network, and
then try again. If it still
cannot be located, the
information might have been
moved to a different
location.

UpiKzOpu-1at~d
Mee¥clvM+20[@ 6
~r0f Q:K"?WS
®c b20bM%rSc
g% @4#Y I €8§TAV]
Ou-12@Pr&g 1€+
6@6~rM
-FEGC“-Yiw@
Windows V[-¢TEY _
AWZ8e
-ecU-aCc“-vY t@
Windows V[-¢TEY _
"WZ8-e

KZ v:M@"8-84«°1Y1t/leWZsZCTI
8

FEG“-Ytw
1. [Start] > [Settings] > [Control Panel] > [Folder
Options] T4E¥KrM

2. [View] tEtijUpiKrM
[Advanced Settingsf —abM$ Wr[«R1
YKrM

4. [Use simple file sharing (Recommended)™ p
Tuj«toeC_KZ?} [OK] ti0uiKr
M

ecl0-a ¢“-Y t

1. [Start] > [Settings] > [Control Panel] > [Folder
Options] T4E¥KrM

2. [Offline Files] +tEtiUpuiKrM

3. [Enable Offline Files]* ™ pifpj«toeC_
Kz?} [OK] tiUpiKrM

C:\temp\< subdirectory >\
setup.exe - Access is denied.

The process cannot access the
file because it is being used
by another process.

0 file(s) copied.
1 file(s) copied.

"a—4«°TY@»KKr
KS

§1TATUET°KZ?} §1A "EUEfioU
a&b"8-4a«°1Y >8P.5-16"' 0°3UI€Z8m
8pt /eKZCTIS

Windows Management
Instrumentation (WMI) is
running.

The setup program has
detected Windows Management
Instrumentation (WMI)

services running. This will

lock some Cisco Security
Manager processes and may
abort uninstallation

abruptly. To avoid this,
uninstallation will stop and

start the WMI services.

Do you want to proceed?
Click Yes to proceed with

this uninstallation. Click No
to exit uninstallation.

E[ WMI @ Q#YI1€Z8-
? 11?7@1 WZ&§TAVD
WMI §TA«t—¢TEY _
KSet+ 6@6~rM

[Yes] TiUpiKrm

[ OL-26559-01-J
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Security Manager

O

Security Manager

iO-"8°bo0EY©OxT, +4¢

"4-84«°TU@A&C"PEKS ®c]:KS}88[M?
UE1°KZ?}v:M@0&KZsZCTIS8

"a-8«°10_

crmdmgtd8 1A« @ AAKZ878\8: /& bOpu-12@/2&g 1€

Do you want to keep waiting3\a}€S ec]:KS}88[M?

n 2

d—&4«°iyY

«jUE° ¢ «jUE°@+-0""°M+S_é¢_AAK~?2WS
crmdmgtd 8§ TA«T6FMeeéc@uUr€z8rM

[Yes] tiUpiKrM o\f]lb ce

crmdmgtd§TA«c Qbc« £¢]>~_BFKrM

iU="4°pb°U

hY Vg

EYOXT e

>

ac

Gb8o[c b$2e_ >A<KrM
e —&«°TYpbjU0-"480°7€ >&P.A-10>'
e —4«°TY<bi0-"40°7¢€ >8P.A-13>"
o A\ » o
—a«°TYpbjU-"a0%7€
Q. i0-rac° TCOT™ h & «°TYI_/2&g1€SGb-8«°iY §07 Oup-12c
]:8:—a[M?
A. jU-"3§c° TGoT™h—&«OTY 307 Op-12\1 At 2 A5 _&gKrM Gb/?
c>8EbePb”YC“Eu°8p_jm}€Z8rM
P A5 —4«°TY 807 Op-12>&;0-"4°"
Message Op-12b##a 1778
Could not install engine jar @Sh co~m” —a«°] 1. b\>~ &4 -KrM

Y\"8-8«°TY@NI[
InstallShield @ GKC-8KZ8
rof

C:\Program Files\
Common Files\
InstallShield\Universal\
common\Genl

2. GenlC>Y2biSt8fKzZ?} v:M
@ Security Managef U—-"8°b -4 «
°TYt06KZsZCTI8

Genl@N~K"8 ec a&f~_
commonbiStsSfKrM
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Security Manager jU—-"4°b°0EVY©xT,+4¢
2 A5 —4«°TY 507 Op-1>&j0-"3°%" >&)F A>'
Message On-iab##a i i8
Error - Cannot Connect to §TA@1 Wz HTTPS°U 1. EO0O~"?}
Server Cepi#Y 0¢ IE€Z8eot https://<server/CSCOnm/servlet/login/logi
The client cannot connect to 6@6~rM n.jsp _ 6+ Cisco Security Management Suite

the server. This can be
caused by one of the

following reasons:

The server name is incorrect.
The protocol (http, https) is
incorrect.

The server is not running.
Network access issues. Please
confirm that the server name
and protocol are correct.

The server is running and you
are not experiencing network
connectivity issues by

loading the CS Manager home
page in your browser.

l«iUE _R¢—&KrM

[Server Administration]t jUpj KrM
[Admin] “ea» "
T4AE¥KrM

4. TOC [ [Single Server Management] >
[Browser-Server Security Mode Setup}E ¥
Kz?} [EnableleE©U& T+a @4E ¥
1€Z8+G\1&1 KrM

eEOUA T+a@AE¥I€Z28~2?2WS

[Server] > [Security]

cec Q€T4E¥KZ?} [Apply] tiUp
iKrM
5. ERAE°@/2&g1£S} Cisco

Security Manager Daemon Managen2s -
KrM

6. 5(..Wz?} v:M@ Security Manager
iU-"8°1TQ#YKZsZCTIS
Q€[VKF[A*8 ec 501
-12@&gKZ8+Ube+t 6b6ee8Y T
@0'KZCTIS8

Oou

Error - Cisco Security Agent
Running

Installation cannot proceed
while the Cisco Security
Agent is running

Do you want to disable the

iU-"8°b-8«°TYp

¢ Cisco Security Agentt 6 F

M*20[@ 6 ~rM

« Cisco Security Agentfte-TEY_Ms
cec [Yes] TiUpjKrM

« i8tYOa-YKZ
tm-[6FMe ®c
rmM

Cisco Security Agent
[No] t+i0piK

+ Security Manager U-"4°baealU-4a

Cisco Security Agent and EVE "i-«Ms e Help] 11
continue with the o= [ i
installation? UpiKrM

Error - Cisco Security Agent Security Managef U-"40°? [OK] *i UpiKZ Gbg 01 o u-tat

not Stopped

The installation will be
aborted because the Cisco
Security Agent could not be
stopped.

Please attempt to disable
Cisco Security Agent before
repeating the installation
process.

} Cisco Security Agentt 6 F [

Arof[KS

6AL —8«°TYtpeKrM v:M@-4&
«°7Yt0eMS _ Cisco Security Agentt m -
[t+-TEY _KrM
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| Security Manager

iO-"8°bo0EY©OxT, +4¢

P A5 —&«°TY 3507 Op-i»>&j0-"4%" >&)F A>'
Message Op-12b##a gii8
Error occurred during the @Shb go ™~ —8«°f 1. C:\Program Files\Common
installation: null. Y\"&-8«°TY@NI Files\InstallShield\Uiversal\common\Genl
InstallShield @ GKC -8KZ8 &4 -KrM
ros 2. GenlC>Y2biSt8fKZ?} v:iM
@ Security Managef U—-"8°b -4 «
°iY 106 KZszZCTI8
Genl@N~K”*8 mc &f~_
commonbiStsfKrM
_EFFOVS qccurred during the Re—& "e~a° _'o#."" Windows'o#.*..\KZR¢-8KZ?} v:M
'”.Sta':i}:f”' @Uzl1€z8+ Windows @i | @ Security Manageri U—"&°b—-8«°7Y
"TE@ Security Manager t0eKZsZCTI8
Client T —4«°TY[ArM
Internet Explorer cannot i0-"8° ©«,OVb OS@ |1. [Start]>[Control Pang> [Add or Remove
download CSMClientSetup.exe Windows 2008b ce c Programs]t4E ¥ K r M
from < server >. Internet Internet Explorer-Y x U | « |
Explorer was not able to open . 7o b g 2. [Add/Remove Windows Components];
this Internet site. The b 1AQ Y AOC @NIJ[ OpiKrMm
requested site is either §TA?}jU-"4° ¢ )
unavailable or cannot be ~TMT 8 «07Y @i, -0 3. Windows¥4ali¢ ac° el Ted»
found. Please try again et2TART»[ANG e+ "@648S} [Internet Explorer Enhanced
later. b@6~rM Security Configurationp ™ pujTpj«toe
C_KZ [Next] 1i0puijK [Finish] t
iUuiKrm
Please read the information BA«IT«@Y (*»0-E [Back] tiUuiKZz?} Security Managerf
below. rScAT +OUAV _ U-"8°t-&«°TYM+9b d14E¥K
The following errors were Sec‘j”ty AI\/l’anagen Uu-~a° ZCTI8
generated: T-a«®TYK[:\KS e+
6@6~rM
e WARNING: The < drive>
partition has
insufficient space to
install the items
selected.
Unable to Get Data §TA 1T+xET«@62_" X(..WZ?} V:M@RC-A4KZsSZCT
A database failure prevented >MeS_ jU-"4&°1Q#y 18 e8Y @0Z061€78 cec 20["MmZ
successful completion of this KZ8TA_KFK|:\KS: b§TA«@ /eKZ8+G\1&1 KZCTI
operation. +0@6~rM 8
Q. iU-"a° —8«°10U@ # tp>&A&C¢"UE>KS ec]:KS}88[M?

A.

jU="48c0°

bm8pt06KZsZCTI8 8NE€?2bm8p[e8Y @0Zb61€+++ 6@6~rM
©«,0V_"83"-Y«

TCOT™M @ -8 «°TYIEZ8. cecC

QE€t1e-TEY_KZ?} ViM@B-8«°i0Ut /eKZsZCTIS8

iU-"4§°

[0-"a0

8:501

©«,0tUE1T°KZ?} v:M@-4«°10t /eKZsZCTIS8
©«,OV[EU""TQ#YKZ
Security Manage8TA_R¢—-&KrM
Ou-12@rP&gIES oec 20[°

http:// <server_name:1741 _6 -
Forbidden rSc Internal Server Error\
Tomcat§TA«@ /eKZ8rOt ¢
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Security Manager jU—-"4°b°0EVY©xT,+4¢ ||

3ESTATUET°KZ Tomcatb' >r[_ ("66@"?WSG\@"8 x=c
§TA RBR¢t&1 M+*? QbUb«, pET leKZ Tomcat @ - 8 K Z 8~ 8#.#4 T1*
Me20[@6~rM

—8«°7T0_ eSbAT2U&biU-"8°@-8«°TYI€Z8«Su”8-8«°T
YI€«\8:/F bOpu-12@/2&g1€rM K?K €SbAT2U8bjU-"8°°c-
4«°TY1€Z8r0t GE€c7€ [M?

iU-"8°b-8«°TYrScli-4«°TYp_ —-a4«°10@-8«°iyl€zsgn
8iU-"4°1t¢é KZ QbijU-"84°@"&4—-4«°1YI€«\8:/F bl WSOu
-12128gM+G\@6~rM GbOpu-12¢c ©«,0/& "l b,8pbp2a«°U
"U@gWZ8+G\@NI[2&gI€rM GbOu-12@/28gl€zviU-"8°b-4
«°TYcG- 4/eKrM@ b2«°U §le+TQ#YKZ bYTTP7VK O<b-4
«°TY[GbOu-12@r2&Y1€78|:_KrM
HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Nodéicrosoft\Windows\CurrentVersion\Un
instal\Cisco Security Manager Clie@ p2«°0 &§1e+164C _c [Start] > [Run] T4E ¥ K

Z regedit \°SKrM> rS C:\Program Files\Zero G Regiy\.com.zerog.registry.xmg “
—YbiSTEfKrM>&]t"iS[ve>'

o
Qo

—8«°TY<bjU="4°7€

Q.
A

—4+TC™M-«@GKC/&gI€"8bCc "P[M?

,8A1@>&¢UC pj«>'oin»c »0-A TCoT™ i "HE¢PI»KAEEd
Security Manager GUF GK C/2&gK~ 8+ 6 @6~rM Ghe8Y@;U—-"4° ©«,0
_S8jMe?]:?1 «°Me_c¢ [My Computer] tjUpniKz [Properties] t4E ¥ K
[Hardware] t4E¥ K Z [Device Manager]t jUpiKZz?} [Display adaptersga°cUtz
6AKrM "2E+b8&°UT2EY{UpniKZ Q#YI1€Z28»U-AbAT2U&t&
1 KrM Qb<[ b8N€?2t /e[ArM
— jU-"4° ©«,0[ ATIMOBILITY FireGL At «T»@Q#Y1€Z8« e
+i» U“KZ8SAtee »U-Ae¥b»U-AT°mMKAEEd""}"*"8 e @6~
rM Q#YMe»U—-Ac m-| Direct 3D @0¢ [A<20[@6~rM Gb|: p+
br8»U—-Ac Security Manager GUKE bO[(0 T jU—-"4° ©«,0 _P&g[A"S
+ 0@6~rM

— At «i»b cc PC Ofs\el» Ofeb Web§-°_"{-«KZ q,b
Java2¢ UCepj« U-EUUDR&Y\DB8 «n6T3™puiKZCTI8 ©%xh8 «n
@gWZ8+0\1]bET«] (eVbOTe@«ndb6e»U—-At°mKZ-
d&«°TYMeSubmetfjKZ8rMm

¥e1 AT2U &b Windows b [Start] O % x1_ Security Manager U -"4° @/2&g | €
8bcrP[M?

i0-"8° ©«,0V[el TQ#YMe|:_ ..&\01 beEOUAaT0; KZ8se+
6@6~rM ¥e1 A72U4Db Windows /£ b0O+1 \KZ,el c§11°1€Z28r0t ¥
&°RTY A¢VYTQ#YKZ 01 T¥e1 U-p°KZCTIS

Security Manager U-"8°@ -8 «°1YI€SaTj«,TOUA&V[MASrSc24SD

@i"b [Start] 0% x1_ Security Manager U-"4° @/2&g1€~8bc” "P[M?
iU-"8°t-4«°TYM+\A_ 0 1t-8«°TYKZ8+@1"S#HYbOUI ey

°t8BM+b? MMZb@T#YbO©UI°eu°t8BM+b? ]b@i#Ybo©UT°
*U°V8BKA"8b?TAE¥KIM —8«°TY< _Gb4E¥TEfMe cc Cisco
Security Manager ClienG>Y 2t Documents and Settings\<us&start Menu\Programs\Cisco

[ OL-26559-01-J
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Security Manager

iO-"8°bo0EY©OxT, +4¢

Security Manager? } Documents and Settings\Allsers\Start Men#rograms\Cisco
Security Manager ¥ £TM+G\_|WZ m-[3f[ArM ©Ui°epu°t8BK"8

G\_KS ®c & I€S AllUsersC>Y2& o©UT°«p°tm-[8BM+20[@ 6
~rM

Q. iU-"a° ©«,0\87TA6bKF@$ — 4 8\oLe @ rSc RE—&1_ DNS
sUT@rP&g1€s cec]:KS}88[M?

A. iU-"8° ©«,0Vb hostsC“-Y /A _ Security Manage8TA#Yb34°0Ut8BK~"
E€d"}"8 c@6~rM Gb|:~34°Uc ¢ poaij#Yb DNS §7A _$i6 |
€2878 ;®_81AIbKFDb&'g_zgXe+t 6@6~rM jU-"4° ©«,0V]
Gbw ~38°Ut8BM+_¢c OO'rScQbUbEDPTA Y« StextQ#YK
Z C:\WINDOWS\system32\drivers\etc\host$a ArM>& i «° C“-Y+-/_58°0 b33
*% 2 _66M+00(y "m8p@—-NI€Z8rM>'

Q. Security Manageri U-"8°t Q#YKZR¢-4K|:\KS\A_3501 Ou-12@7r&g
[ €-G\*"CRC-42(A_ @QWE°€}€rKS@ Security Manager « j°uE @'5 b
"gA[Q#Y[ArO% 10E-p°"uEb1 @664*WZ8+b[K{:?>&rS
Security ManagersTAVb Common Service§R¢ —&2(A_ @QWE°€}€rKS @

Web EU~"V[ Cisco Security Management Suite °MEbRT» _»KKrM GE€v
LNI[K{:?>

A. Security Manageh Common Services PKZR¢-&10E§TA«tfjMeSub Cisco
Secure ACS_20[*« JE@ 6C¢KZ8"8e+ 6 @6~rM ACS[RC¢—-&2(A_ t°
SKrkS@ Security Manager§TAt AAA jU-"8°\KZ *OKZz8rOt Gb *O
tle fA"E€d B¢—A4[ArO% 00K8m8p_X8Zc ACSbbP¥%x"Ytgl-KZC
T18

Q. Security Manager U-"4°t Q#YKZ8TA_R¢—4[AN b|:~Ou-12@r&g
l€rM ]1:KS}88[M?

... repeatedly thatthe | §TA@ q 7THbAT» "™ "0[6\ " C°"™"0[61t6SKZ8*

server is checking its G\t&1 KZCTI8 §TADbO[6>|gNa!8o >8P.3-3>' t g

license. I.LKZCTIS8

Synchronizing with 230~be+ 6 @*f<}€rM

DCR.

e §TADbI2s %$<«_  Security Managef U—-"8°12s-KS
+0@6~rM Qb c §8TA@0O2_Q#Y e+ _Ner]
X(...WZ?} Security Managei U-"4°1Q#YKZsZC

TI8

o CiscoWorkso#. A« ai»_"&A§a»>& &>'"]1b"Ifeb @
UFr€EZB8ee+ 5@6~rM Qb)Y Security Managem —
a«°TYi_8TAVD NMSROOTlib\classpath§ Ets b j©

U[ comUserdatC“~Y1t8B[ArOf[KS GG]|
NMSROOTc Common Services —4«°TYKStep ol
[M>&1C>Y°c  C:\Program Files\CSCOpkM>'

a. CiscoTAC _4)'Kz comUser.datb°nrSc
Security Manage 1 -4 «°7Y _66Ms+-|T0[13KZC
TI8

b. rSc"IfeDtur~8 Common ServiceA «a1» 18
BKrM

Cisco Security Manager 4.3 -&«°pioU4 Z—»
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Security Manager jU—-"4°b°0EVY©xT,+4¢ ||
Error - Unable to b§TA«b8NE?@GKC2s-KZ8"8+ 6 @6~rM
gzrev‘;kr License on §TAV[  [Start] > [Programs] > [Administrative Tools] > [Services]
’ tAE¥KZ b|:*"iSb8TA«t* jUpuiK ©UT°ep
An attempt to check ° 0% x1?} [Restart] tT4E¥KrM
the license file on + Cisco Security Manager Daemon Manager
the Security Manager
server has failed. » Cisco Security Manager database engine
Please confirm that « Cisco Security Manager Tomcat Servlet Engine

the server is running.
If the server is

» Cisco Security Manager VisiBroker Smart Agent

running, please » Cisco Security Manager Web Engine

contact the Cisco ~

Technical Assistance 5(..WZz?} viM@  Security Managef U-"4°12s-KZs

Center. ZCTIS8

Q. 1C>Y° EU~"\KZ Internet Explorert Q#Y KZ8«\A_"j <A Piie @/
&y 1€78bc P[M?

A. Gbe8Yc!* "pa«°U Yili rSc Internet Explorer_664 UE}€S DLL C“-Y

O

O

b d 66M+664*8@NI[$1#OKrM Gbe8YbP 2 _X8Zc
http://support.microsofcom/kb/281679/EN-US? } °m e+ ~  Microsoft §11°«/j _ b0°
' 28167919l -KZCTI8

]:M€d R¢—-4& “ed»~b [Server Name]C+TY »?}8§TA U«ot~d[ATrM

?

csmserver.txtt)...7Y KZ20[b~834°UtP7VKrM GbC“-Yc Security Manager
iU-"8°T-8«°TYKStepij°U&E 6~rM 1C>Y°b dc C:\Program

Files\Cisco Systems\Cisco Security Manager Clighit

Aiau& N«DPus@NI[ Security Managef U-"38°@RI»I€"?WS++ 6@ 6
~rM G€c]:8:-4a[M?

SecurltyManager§|AbA|aUa\ U-"8°bA12UA@M+ KZ8rOt GETY
GMe+_c q,bjU-"4 —a<<°|0T§TA’>}2 ART»KZ-&«°TYKr
M

i0-"8° R¢ C“-Yclb d_6~rM?

i0-"§c° R¢ C“-Yc C:\Program Files\Cisco Symns\Cisco Security Manager
Client\logs _4A*(1€Z28rM GUI -p©UA&H\_S#YbR¢ C“-Y@8BIE€rM

Security Manager@HTTPS Oi»[-8p?]:?2c]:M€d&1 [ArM?

b8NE€?T /eKrM

o EU""TOQ#YKZS8TA_RC-&KS} "»b« C+TY»Zb URL t1* KrM
URL @https|[ rwz8€d Security Manage@HTTPS O1»[-8KZ8rM

+ [Common Services] > [Server] > [Security] > [Single Server Management] > [Browser-Server

Security Mode Setup] &4 - KrM  [Current Setting]@[Enabled]_~"W ZzZ8€d Security
Manager @HTTPS Oi1»[-8KZ8rM Gbo, @ [Disabled]b cec HTTP T Q#Y
KrM

[ OL-26559-01-J
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WM s7A -YG,«°ble

§TA

«,nE

«,nE

«,nE
«,ME

«,nE
«,nE

o jU-—"&°TQ#YKZREC—-&M+\A_ rN HTTPS O1» 106 KZsZCTIS8

SEHTTPS] 3™ pjTpji«ted_KrM> Login URL access is forbidden; Please make

sure your protocol (HTP, HTTPS) is correcth 8 : O pu-12 @/28g1€S} §TAc
HTTP OT»[-8KZ8eet 6 @6~rM [HTTPS] e ™ puiTpj«teC_KZ
V:M@0eKZsZCTIS8

Q. ]:M€d jU-"4° 1Ape B¢ PEYT—¢iEY_[ArM?

A. 1C>YO] C:\Program Files\Cisco Systems§€d Security Manager Client\jarssA*(1 €2 8
« clientinfo C“-Y /£ DEBUG_LEVEL AUOT+_ DEBUG_LEVEL=ALL t33a+KZ?
}  Security ManageiU—-"8°t12s-KrM

Q. 2#i8 SB[8 KZ8+ ecC Security Managerp U-"8°@" 2#8 V[-8KZ82Z
v 2N "l b «&»"\TuE"pnE Ou-ia@" 1#i8 _2&gl€rM S\<d
i0-"4°@" 2#8 V[-8KZ8+\A_ 2N Policy Object Manager]b~«a»
@ 1#8 [P&gIE€rM GE€TYG[ArM?

A. GE€c"l belbi, sac ©«,0 _>Ee+ 2#8 811°b /@% 2 _ :0%+*be8Y
[M Security Manager U —"&° 1" 1#8 V[-810«G\tTNaKrM jU-"4°
C 2#8 SBh0O; < 25-M+20[@6~rM
Ub#i8 ["+84»" @648S oecC Alt + « 1T« ATT2KS < _ M1t2MG\_|WZQ

b e&» " t&4-[ATM Qb<[ %®3VitTQ#YKZ +&»~t&4-KrM

Q. i0-rac° ©«,OV[ CO"™"+_3«°TYrSc”a-&«°TY[ArOt ]

KZ[M?
A. j0U-"3° ©« OV[-&«°TY\"8-8«°TYT /i l®KS ®c Q£}@
9 b’EUELTOUA&_PMevb[6WZV jU-"4° ©«,0b InstallShield: 1+
Eil« 8428_0s8tZ< C°"™"ph—-4«°TYrSc”d-4«°TY@[A"
C~r~rM 00(y_X8Zc Cisco.com”+~8°_R¢-A4KZ?} Bug Toolkit T Q#Y K

Z CSCsd217222 CSCsc91430t&1 KZCTI8

-YC ., «°b /e

Security ManagerSTA@ GKC-8KZ8+G\1&1 M+-YC,«°f /eeMe+_c bm

8pt /leeKrM

1  Security Manageri U-"4°@ Security Manage8TA_K)FI1€Z8.©«,6 0?} [Tools] >
[Security Manager Administrationf4E ¥ Kr M

2 [Administration] ~« & » " [ [Server Security]t jUpijKz?} 6-bl+xa&t;UpiKr
M ,KSBEU""@648Z UujKST+&_PAM- Common Services GUb-Y x U | »

0, lT2@/2&gl€rM

[Common Services]i2b  [Server]xE[ [Admin] T4E¥KrM

[Admin] Ti12b TOC [ [Selftest]TiUpiKrM

[Create]t iU pujKrM

[SelfTest Information akMM-DD-YYYY HH:MM:SS] U&;tiUuiKrM GG|
¢« MM-DD-YYYYc #~bv ¥ °[M
e HH:MM:SSc [Selftest] tTjUuiKSi ( &E12M+x-O«+8E[M

o 01~ W

Cisco Security Manager 4.3 -&«°pioU4 Z—»
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§TA °UEYO©xT,4¢_ bp7¥ ||

«,ME 7 [ServerInfo]1i2[§4°Ut1l sv~rM

§TA °U

- » ° -
EYOXxT,ea¢_ bp7Y

Security Managef e8Y @$1#0Kz>~ 307 Oup-12A£bN4a'8BobMmZ10éK Gbb
Y%x"Y/EDbe+t 606+0Z0CT&1 KS_Vv??2f}N e8Y @0Z61€"8 cec Security
Manager Diagnostic®d 1, U « T Q#YKZ8§TA_ tp7YKrM

Security Manager Diagnostic® 1, U +c ZIP G“-Yb CSMDiagnostics.zip? } §1A0G »
_ Tp7YKrM GbGC*“-Yit38fKA"?WS cc Security Manager Diagnostics /ce M
*Sg_,K8_ [C“-Y@VIiAIErM CSMDiagnostics.zipC“—~Y/Z£b_ ¢ §1A

V b Security Manager Sc664 "EUE£1©O U4 [$i#OK Se8Y b © « ¥ Liv%evsgito !
als” |«0ZOtT-|KrM

Security Manager ¢ "EU£1OU&_|WZ <1€S0; §f_66Mse_ Tp7Y M+9x @

AAp ac cEQUAVHY-1€Z8rM GbeEQUAT"|,*E_Me+_c [Tools] >
[Security Manager Adminisation] > [Debug Optionslf4E¥ Kz ?}  [Capture
Discovery/Deployment Dalgging Snapshots to File]™ pjTpj«tea_KrM 0CsC“-Y
_—NI€SQbUb_ c°UEYOxT,s4¢h0es_zgXe+ 6@6~rM@ C“-V_
cCA«ai»"]bp&_ @IiA3,r€Z8 c@6+G\_@-KZCTI8 tAutc bE
Yc Cisco Technical Assistance Cent@fFAC>' ?}5ft&e&glI€S o TESfKZCTIS

Security Manager Diagnostics b8N€?b % 2[ /e [ArM

Security Manager

iU-"8° ©«, 07} Security Manager §TA?}

1. §TAlb  Security Managei U—-"4° -u 1. Windowsb¥ba» ~“+&»~164ArM Q€ _c S\

} [Tools] > [Security Manager <d [Start] > [Run] T4E¥K command\°SKrM

©oU&t&'gKS
Diagnostics]tiUpniKZ [OK] TiUuiKr |, 1. o5y C:\Program Files\CSCOpx\MDC\
M bin\CSMDiagnostics rSc Gb  ZIP C“-Y ¥
CSMDiagnostics.zipC“~Yc §81AVb NMSROOTMDC\etc\\c9b d_—-RNM+_c
NMSROOTMDC\etc\ tebjoU_—NI€r CSMDiagnosticsdrive:\path\°*SKrM S\<d

M GG[ NMSROOTc Common Services CSMDiagnostics D:\temp° SKr M
—8«°TYKStebjoU[M>& C:\Program

Files\CSCOpx~ >

2. [Close] tiUpj

>&@> Gb@i U,
€78]: GbC“-Yb{St&fM+G

\tNaKrM

KrM
et l,eMeSg_ViAl
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| §TA ER-«

«, Tt «bl&g\&f

8§TA ER-« « 1+«bl&g\&f

«

HE

1
2

3

Security Manageh 81A ER-«@GKC-8KZ8+G\t&1 M+e_c bm8pt /eKr
M

CiscoWorksbi1O112] [Common Services] > [Server] > [AdmMIinf4E ¥ K r M

[Admin] 112b  TOC [ [ProcessesjtjUpiKrM
[Process ManagementiEY _MmZb§1A ER-«@/?&g1€rM [ProcessState} U O /£
b34°U@ ER-«@G—-_-8KZ8+?]:?21t&gKrM

Q[ ER-«@-8KZ8"8 ®c Q€tTI2s-KrM
>8P.A-18"' T gl-KZCTI8

§TAVb2ER-«bi2s-

>& @>' RiVYo#*.."I'’taX@1 " bs@8&TA ER-«12s-rScOF[ArM

STAVb2ER-«bI2s-

«,nE
B

«

>&@> MmMZbER-«T8FKZ?} Q€}ti2s-KAE€d Gb% 2cp+ KrO#

1
2

¥Pb&» ERAE?] net stop crmdmgtd \°*SKZMmMZbER-«T8FKrM
net start crmdmgtd \°SKZMmMZbER-«t12s-KrM

A&° rSc [Start] > [Settings] > [Control Panel] > [Administrative Tools] > [Serviceasg|E ¥ K Z
?} Cisco Security Manager Daemon ManageRs - [Ar M

—ad«°iY R¢ C“-Yb&1

§TA?}bAA@+..KZ8Svb\W4*WZ8S cec §1A —&«°1Y R¢ C“-Y[3
U1 Ou-12a\a™iOpu-12t&1 [ArM

,Y«® 3lextQ#YKZ C:\Ciscoworks_install NNNlog t64ArM GG NNN ¢
YYYYMMDD_HHMMSS g'b+z-0«8E[M

o\i]lb & &1 MmARC C“-Yc C“-Yj_q*xb$ -@UE}€SC“-Y? 8
B¥@q,bC“-Y[M
S\<d R¢ C“-Y[c b|:~801 §4°0\I™is3°U@&1 [ArM

ERROR: Cannot Open C:\PROGRA~1\CSCOpx/lib/classpath/ssl.properties at
C:\PROGRA~1\CSCOpx\MDC\Apache\ConfigSSL.pl line 259.

INFO: Enabling SSL....

WARNING: Unable to enable SSL. Please try later....

Cisco Security Manager 4.3 -&«°pioU4 Z—»
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> @> 5 +7e8Y @$IHOKS ec R¢ C“—Yt CiscOTAC 3 ™M[ArM D¥%x"Yb°m% 2
>|g.i%eY §11°  >8.xiii> tg!-KZCTIS8
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APPENDIX B

Cisco Security Manager _66MeceTE4
T« U-—-3«30%+

eTCOoT ™ O--8«_6064 M30%+ &£ t &IKrM
* OpenSSL/Open SSL ProjecttP.B-3>'
e AXis >&P.B-4'

« Castor>&.B-7'

» cglib >&P.B-10>'

* Velocity >&P.B-13'

* Apache Commons&P.B-16>'

« ODMG >&P.B-19"

* log4j >&P.B-20

» jdt-compiler-3.1.1.jar>&P.B-22"

* jta-1.1.jar>&P.B-26>'

» slf4j-api-1.5.2.jar>&P.B-28>'

¢ Quartz 1.8.0>8P.B-29'

« Java(TM) Platform, Standard Edition Runtime Eowviment Version 6 (Java SE 6 Update 30 or JRE
1.6u30) >&P.B-32'

* Lucene>&P.B-38

» Google Protocol Buffers-&P.B-41>'
* Innovation HTTPClient>&P.B-42"'
« Jakarta-ORO>&P.B-42'

e java-diff >&8P.B-45>'

* javabi-sizeof>&P.B-46>'

+ JGoodies Forms-&P.B-46>'

Cisco Security Manager 4.3 -&«°pioU4& Z—>»
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o« JIBX >&8P.B-47'

* jNetStream>&P.B-48>'
+ Restlet>8P.B-48

»  Spring >&P.B-48>'
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OpenSSL/Open SSL Project

License Issues

This product includes software developed by @penSSL Project for use in the OpenSSL Toolkit
(http://www.openssl.org/

This product includes cryptogphic software written by Eri¥oung (eay@cryptsoft.com).
This product includes software writtdoy Tim Hudson (tjh@cryptsoft.com).

The OpenSSL toolkit stays under a dual licensebbéh the conditions of the OpenSSL License and the
original SSLeay license apply to the toolkit.See fefor the actual license textActually both licenses
are BSD-style Open Source licendesase of any license issuetated to OpenSSL please contact
openssl-core@openssl.org.

OpenSSL License:
Copyright © 1998-2007 The OpenSSLokact.All rights reserved.

Redistribution and use in source dridary forms, with or without mdification, are pamitted provided
that the following conditions are met:

1. Redistributions of source code siuetain the copyright notic#is list of conditions and the
following disclaimer.

2. Redistributions in binary form nstireproduce the above copyrighticet this list of conditions, and
the following disclaimer in the documentation andsthrer materials provided with the distribution.

3. All advertising materials mentiong features or use of this sefire must display the following
acknowledgment: "This product includes software d@ved by the OpenSSL Project for use in the
OpenSSL Toolkit ifttp://www.openssl.org/.

4. The names "OpenSSL Toolkit" and "OpenSSL Betj must not be used to endorse or promote
products derived from this sefare without prior written permsion.For written permission, please
contact openssl-core@openssl.org.

5. Products derived from this software may notchéed "OpenSSL" nor may "OpenSSL" appear in
their names without prior writtepermission of the OpenSSL Project.

6. Redistributions of any form whatsoevaust retain the following acknowledgment:

"This product includes software dieoped by the OpenSSL Project for use in the OpenSSL Toolkit
(http://lwww.openssl.org/.

THIS SOFTWARE IS PROVIDED BY THE OpenSRROJECT "AS IS™ AND ANY EXPRESSED OR
IMPLIED WARRANTIES, INCLUDING, BUT NOTLIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTIQLAR PURPOSE ARE DISCLAIMED.IN NO
EVENT SHALL THE OpenSSL PROJECT OR ITS CONTRIBUTORS BE LIABLE FOR ANY
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFS; OR BUSINESS INERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT
LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY
OUT OF THE USE OF THIS SOFTWARE, EVER ADVISED OF THE POSSIBILITY OF SUCH
DAMAGE.

This product includes cryptograplgoftware written by Eric Younge@y@cryptsoft.com).This product
includes software written by i Hudson (tjh@cryptsoft.com).

[ OL-26559-01-J
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AXIS

Original SSLeay License:
Copyright © 1995-1998 Eric Young (eay@ptsoft.com).All rights reserved.

This package is an SSL implementatisritten by Eric Young (eay@cryptsoft.com).
The implementation was written so tasconform with Netscapes SSL.

This library is free for commerdiand non-commercial use as loag the following conditions are
adhered to.The following conditions apply to all cddend in this distribution, be it the RC4, RSA,
Ihash, DES, etc., code; not jube SSL code.The SSL documentatioalied with this distribution is
covered by the same copyright terms except ttmatholder is Tim Hudson (tjh@cryptsoft.com).

Copyright remains Eric Young's, and as such any Cghymnotices in the code are not to be removed.If
this package is used in a produgtic Young should be given attributi@s the author of the parts of the
library used.This can be in the forofia textual message at progratartup or in documentation (online
or textual) provided with the package.

Redistribution and use in source asidary forms, with or without wdification, are pemitted provided
that the following conditions are met:

1. Redistributions of source code stuetain the copyright notic#his list of conditions and the
following disclaimer.

2. Redistributions in binary form must reproduce #i@ve copyright notice, ihlist of conditions and
the following disclaimer in the documentation andstirer materials provided with the distribution.

3. All advertising materialsnentioning features or use of ttgeftware must display the following
acknowledgement:

"This product includes cryptogpaic software written by EriYoung (eay@cryptsoft.com)”.

The word 'cryptographic' can beft out if the routines fronthe library being used are not
cryptography-related.

4. If you include any Windows specific code (oderivative thereof) fronthe apps directory
(application code) you must inde an acknowledgement: "Thisopiuct includes software written
by Tim Hudson (tjh@cryptsoft.com)".

THIS SOFTWARE IS PROVIDED BY ERIOUNG "AS IS" AND ANY EXPRESS OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED.IN NO
EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, ORCONSEQUENTIAL DAMAGES (INCLUDING, BUT
NOT LIMITED TO, PROCUREMENT OF SUBSTITUE GOODS OR SERVICES; LOSS OF USE,
DATA, OR PROFITS; OR BUSINESS INTERUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISERARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OHHE POSSIBILITY OF SUCH DAMAGE.

The license and distribution terms famy publicly available version or deative of this code cannot be
changed.i.e. this code cannot simply be copietirt under another distribution license [including the
GNU Public License].

Apache Axis is an implementation of the SOABiple Object Access Protocol") submission to W3C.
From the draft W3C specification:

Cisco Security Manager 4.3 -&«°pioU4 Z—»
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License

FSOAP is a lightweight protocol for exchanging stured information in a decentralized, distributed
environment.It is an XML-based @ocol that consists of threens an envelope that defines a
framework for describing what is in a messagd how to process it, a set of encoding rules for
expressing instances of applica-defined datatypes, and arvention for representing remote

procedure calls and responses.
[http://ws.apache.org/axis/]

Apache License

Version 2.0, January 2004

http://www.apache.org/licenses/

TERMS AND CONDITIONS FOR USEREPRODUCTION, AND DISTRIBUTION
1. Definitions.

"License" shall mean the terms and conditionsufse, reproduction, andddribution as defined by
Sections 1 through 9 of this document.

"Licensor” shall mean the copyright owner or engtyithorized by the copyrigldwner that is granting
the License.

"Legal Entity" shall mean the union of the acting enéityd all other entities that control, are controlled
by, or are under common control with that entity.Far plurposes of this deftion, "control" means (i)
the power, direct or indirect, to caeithe direction or managementsoch entity, whether by contract or
otherwise, or (ii) ownership offty percent (50%) or more of the atanding shares, or (iii) beneficial
ownership of such entity.

"You" (or "Your") shall mean an individual or al Entity exercising permissions granted by this
License.

"Source" form shall mean the preferred form fimaking modifications, ineiding but not limited to
software source code, documentatgmurce, and configuration files.

"Object" form shall mean any forresulting from mechanical transfortian or translation of a Source
form, including but not limited to compiled objexde, generated documentatj and conversions to
other media types.

"Work" shall mean the work of authorship, whetheSiource or Object form, made available under the
License, as indicated by a copyright notice that ctuided in or attached to the work (an example is
provided in the Appendix below).

"Derivative Works" shall mean any work, whether imu$ce or Object form, that is based on (or derived
from) the Work and for which the editorial revisiomsnotations, elaborationsr other modifications
represent, as a whole, an original work of authiprétor the purposes of this License, Derivative Works
shall not include works that remaseparable from, or merely linkr{bind by name) to the interfaces of,
the Work and Derivative Works thereof.

"Contribution" shall mean any work of authorship;luding the original version of the Work and any
modifications or additions to th&York or Derivative Works thereof, &t is intentionally submitted to
Licensor for inclusion in the Work by the copyright owee by an individual ot.egal Entity authorized

to submit on behalf of the copyright owner.Foe thurposes of this definition, "submitted" means any
form of electronic, verbabr written communication sent to thecensor or its represtatives, including
but not limited to communication on electronic nirggl lists, source code control systems, and issue
tracking systems that are managed by, or on betiathe Licensor for the purpose of discussing and
improving the Work, but excluding communication thatésspicuously marked or otherwise designated
in writing by the copyright ower as "Not a Contribution."

[ OL-26559-01-J
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"Contributor” shall mean Licensor and any individoaLegal Entity on behaléf whom a Contribution
has been received by Licensor and subsetyécorporated within the Work.

2. Grant of Copyright License.Subject to the teramd conditions of thikicense, each Contributor
hereby grants to You a perpetual, worldwide, eactusive, no-charge, royalty-free, irrevocable
copyright license to reproduce gmare Derivative Works of, publicdisplay, publicly perform,
sublicense, and distribute the Work and such Derivative Works in Source or Object form.

3. Grant of Patent License.Subject to the ternts @nditions of this Licese, each Contributor hereby
grants to You a perpetual, worlthie, non-exclusive, no-charge, rdtyafree, irrevocable (except as
stated in this section) patent licento make, have made, use, offesell, sell, import, and otherwise
transfer the Work, where such license applies onthése patent claims liceable by such Contributor
that are necessarily infringed byeth Contribution(s) alone or by conmation of theirContribution(s)
with the Work to which such Contribution(s) wadmitted.If You institute pat# litigation against any
entity (including a cross-claim opbanterclaim in a lawsuit) allegintpat the Work or a Contribution
incorporated within the Work constitutes directcontributory patent infrigement, then any patent
licenses granted to You under this License for that Vébid| terminate as of ¢hdate such litigation is
filed.

4. Redistribution.You may reproduce and distribute espif the Work or Derivative Works thereof in
any medium, with or without modifations, and in Source or Objdotm, provided that You meet the
following conditions:

(a) You must give any other recipients of the WorlDerivative Works a copy of this License; and
(b) You must cause any modified files to carry proemnnotices stating that You changed the files; and

(c) You must retain, in the Source form of any DetilvaWorks that You disthute, all copyright, patent,
trademark, and attribution noticekesm the Source form of the Workxcluding those notices that do not
pertain to any part of the Derivative Works; and

(d) If the Work includes a "NOTICE" text file as paiftits distribution, therany Derivative Works that
You distribute must include a readable copy of thétattion notices containedithin such NOTICE file,
excluding those notices that do notgaén to any part of the Derivai@/Works, in at least one of the
following places: within a NOTICE text file distribed as part of the Derivative Works; within the
Source form or documentation, if provided alonghwthe Derivative Works; or, within a display
generated by the Derivative Works, if and whenesuch third-party nates normally appear.The
contents of the NOTICE file are for informatiomalrposes only and do not modify the License.You may
add Your own attribution noticesithin Derivative Works that Youdlistribute, alongsie or as an
addendum to the NOTICE text from the Work, providledt such additional attribution notices cannot
be construed as modifying the License.

You may add Your own copyright statement tau¥enodifications and may provide additional or
different license terms and conditiofts use, reproduction, or distridah of Your modifications, or for
any such Derivative Works as a whole, providediYose, reproduction, and distribution of the Work
otherwise complies with the conidins stated in this License.

5. Submission of Contributions.Usds You explicitly stat otherwise, any Coribution intentionally
submitted for inclusion in the Work by You to thizensor shall be under the terms and conditions of
this License, without angdditional terms or conditions.Notwitlastding the above, nothing herein shall
supersede or modify the terms of any separatnBe agreement you may have executed with Licensor
regarding such Contributions.

6. Trademarks.This License does grdnt permission to use the trade names, trademarks, service marks,
or product names of the Licensor, except as reqdimereasonable and custorgarse in describing the
origin of the Work and reproducing the content of the NOTICE file.

Cisco Security Manager 4.3 -&«°pioU4 Z—»
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Castor

7. Disclaimer of WarrantWnless required by applicable law oragd to in writing, Licensor provides
the Work (and each Contributor provides@sntributions) on an "8 IS" BASIS, WITHOUT
WARRANTIES OR CONDITIONS OFANY KIND, either express ommplied, including, without
limitation, any warranties aronditions of TITLE,NON-INFRINGEMENT,MERCHANTABILITY, or
FITNESS FOR A PARTICULAR PBPOSE.You are solely responsible for determining the
appropriateness of using or redistributing the War# assume any risks associated with Your exercise
of permissions under this License.

8. Limitation of Liability.In no event and under na@td theory, whether in tort (including negligence),
contract, or otherwise, ugsds required by applicable law (suchdatiberate and grossly negligent acts)
or agreed to in writing, shall any @wibutor be liable to You for dangas, including any direct, indirect,
special, incidental, or coaguential damages of any character arigia@ result of thikicense or out of
the use or inability to use the Work (includingt ot limited to damages for loss of goodwill, work
stoppage, computer failure or malftio, or any and all other commeatidamages or losses), even if
such Contributor has been advisedhod possibility of such damages.

9. Accepting Warranty or Additiomd.iability.While redistributing the Work or Derivative Works

thereof, You may choose to offer, and charge a fee for, acceptance of support, warranty, indemnity, c
other liability obligations and/atights consistent with this License.However, in accepting such
obligations, You may act only on Your own behalf amdYour sole responsibili, not on behalf of any
other Contributor, and only if You agree to indefyndefend, and hold each Contributor harmless for
any liability incurred by, or claims asserted agj such Contributor by reason of your accepting any
such warranty or additional liability.

END OF TERMS AND CONDITIONS
APPENDIX: How to apply the Apache License to your work.

To apply the Apache License to your work, attéod following boilerplatenotice, with the fields
enclosed by brackets "[]" replaced with your owaritfying information.(Don't include the brackets!)
The text should be enclosed irethppropriate comment syntax for the file format.We also recommend
that a file or class name andsdeiption of purpose be included tme same "printed page" as the
copyright notice for easier identifation within third-party archives.

Copyright [yyyy] [name of copyright owner]

Licensed under the Apache License, Version 2.0'{tieense”); you may not usis file except in
compliance with the License.You mabtain a copy of the License at

http://www.apache.org/licenses/LICENSE-2.0

Unless required by applicable law agreed to in writing, softwa distributed undethe License is
distributed on an "AS I1S" BASIS, WITHOUT WRRANTIES OR CONDITIONS OF ANY KIND, either
express or implied.See the Licerieethe specific language govengi permissions and limitations under
the License.

[http://www.apache.orditenses/LICENSE-2.0]

Castor is an Open Source data ligdramework for Java[tm].It's thédnertest path between Java objects,
XML documents and relational tad.Castor provides Java-to-XMLngiing, Java-to-SQL persistence,
and more.

[http://castor.codehaus.org/]

[ OL-26559-01-J
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License

Apache License

Version 2.0, January 2004

http://www.apache.org/licenses/

TERMS AND CONDITIONS FOR USEREPRODUCTION, AND DISTRIBUTION
1. Definitions.

"License" shall mean the terms and conditionsufee, reproduction, andsdribution as defined by
Sections 1 through 9 of this document.

"Licensor” shall mean the copyright owner or engtythorized by the copyrigldwner that is granting
the License.

"Legal Entity" shall mean the union of the acting en#ihd all other entities that control, are controlled
by, or are under common control with that entity.Fa plurposes of this definition, "control* means (i)
the power, direct or indirect, to cseithe direction or managementsoch entity, whether by contract or
otherwise, or (ii) ownership offfy percent (50%) or more of the @tanding shares, or (iii) beneficial
ownership of such entity.

"You" (or "Your") shall mean an individual or gal Entity exercising permissions granted by this
License.

"Source" form shall mean the preferred form fizetking modifications, inciding but not limited to
software source code, documentatsmurce, and configuration files.

"Object" form shall mean any fornesulting from mechanical transfortien or translation of a Source
form, including but not limited to compiled objemde, generated documentatj and conversions to
other media types.

"Work" shall mean the work of authorship, whetheSiource or Object formmade available under the
License, as indicated by a copyright notice that ¢tuided in or attached to the work (an example is
provided in the Appendix below).

"Derivative Works" shall mean any work, whether imu$ce or Object form, that is based on (or derived
from) the Work and for which the editorial revisiormnotations, elaborationsr other modifications
represent, as a whole, an original work of authigr$tor the purposes of this License, Derivative Works
shall not include works that remain separable frommerely link (or bind by name) to the interfaces of,
the Work and Derivative Works thereof.

"Contribution” shall mean any work of authorshipcluding the original version of the Work and any
modifications or additionto that Work or Derivative Works thereof, that is intentionally submitted to
Licensor for inclusion in the Work by the copyright owee by an individual ot.egal Entity authorized
to submit on behalf of the copyright owner.Foe fhurposes of this definition, "submitted” means any
form of electronic, verbal, or written communicatiomst® the Licensor or iteepresentatives, including
but not limited to communication on electronic magjilists, source code control systems, and issue
tracking systems that are managed by, or on betiathe Licensor for the purpose of discussing and
improving the Work, but excluding communication thatamspicuously markear otherwise designated
in writing by the copyright ower as "Not a Contribution.”

"Contributor" shall mean Licensor and any individoaLegal Entity on behaléf whom a Contribution
has been received by Licensor and subsetiyiéncorporated within the Work.

2. Grant of Copyright License.Subject to the teramd conditions of thikicense, each Contributor
hereby grants to You a perpetual, worldwide, eaxctusive, no-charge, royalty-free, irrevocable
copyright license to reproduce gmare Derivative Works of, publicdisplay, publicly perform,
sublicense, and distribute the Work and such Derivative Works in Source or Object form.

Cisco Security Manager 4.3 -&«°pioU4 Z—»
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3. Grant of Patent License.Subject to the terms @nditions of this Licese, each Contributor hereby
grants to You a perpetual, worléke, non-exclusive, no-charge, rdtyafree, irrevocable (except as
stated in this section) patent licento make, have made, use, offesell, sell, import, and otherwise
transfer the Work, where such license applies onthose patent claims liceable by such Contributor
that are necessarily infringed byeth Contribution(s) alone or by conmation of theirContribution(s)
with the Work to which such Contribution(s) waghanitted.If You institute patd litigation against any
entity (including a cross-claim ooanterclaim in a lawsuit) allegingpat the Work or a Contribution
incorporated within the Work constitutes directocontributory patent infrigement, then any patent
licenses granted to You under thicénse for that Work shall terminads of the date such litigation is
filed.

4. Redistribution.You may reproduce and distribute espif the Work or Derivative Works thereof in
any medium, with or without modiations, and in Source or Objdotm, provided that You meet the
following conditions:

(a) You must give any other recipients of the WorlDerivative Works a copy of this License; and
(b) You must cause any modified files to carry proamihnotices stating that You changed the files; and

(c) You must retain, in the Source form of any DetiaWorks that You disthute, all copyright, patent,
trademark, and attribution notickem the Source form of the Workxcluding those notices that do not
pertain to any part of the Derivative Works; and

(d) If the Work includes a "NOTICE" text file as paittits distribution, therany Derivative Works that
You distribute must include a readable copy of théhattion notices containedithin such NOTICE file,
excluding those notices that do nottaén to any part of the DerivatvWorks, in at least one of the
following places: within a NOTICE text file distribed as part of the Derivative Works; within the
Source form or documentation, if provided alonghathe Derivative Works; or, within a display
generated by the Derivative Works, if and wheresuch third-party nates normally appear.The
contents of the NOTICE file are for informationalrposes only and do not modify the License.You may
add Your own attribution noticesitliin Derivative Works that Yodlistribute, alongsie or as an
addendum to the NOTICE text from the Work, providledt such additional attribution notices cannot
be construed as modifying the License.

You may add Your own copyright statement tau¥onodifications and maprovide additional or
different license terms and conditiofts use, reproduction, or distribah of Your modifications, or for
any such Derivative Works as a whole, providediYose, reproduction, and distribution of the Work
otherwise complies with the conitins stated in this License.

5. Submission of Contributions.Usrds You explicitly st& otherwise, any Coribution intentionally
submitted for inclusion in the Work by You to thiensor shall be underehterms and conditions of

this License, without angdditional terms or conditions.Notwitlestding the above, nothing herein shall
supersede or modify the terms of any separaembe agreement you may have executed with Licensor
regarding such Contributions.

6. Trademarks.This License does gaant permission to use the trade names, trademarks, service marks
or product names of the Licensor, except as reqdimeckasonable and customary use in describing the
origin of the Work and reprodutg the content of the NOTICE file.

7. Disclaimer of WarrantWnless required by applicable law oragd to in writing, Licensor provides
the Work (and each Contributor provides@sntributions) on an "8 1S" BASIS, WITHOUT
WARRANTIES OR CONDITIONS OFANY KIND, either express omplied, including, without
limitation, any warranties azonditions of TITLE,NON-INFRINGEMENT,MERCHANTABILITY, or
FITNESS FOR A PARTICULAR PBPOSE.You are solely responsible for determining the
appropriateness of using or redistributing the War@ assume any risks associated with Your exercise
of permissions under this License.

[ OL-26559-01-J
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8. Limitation of Liability.In no event and under na@hd theory, whether in tort (including negligence),
contract, or otherwise, ue$s required by applicable law (suchdatiberate and grossly negligent acts)
or agreed to in writing, shall any @wibutor be liable to You for dangas, including any direct, indirect,
special, incidental, or coeguential damages of any character arisiag result of thisicense or out of
the use or inability to use the Work (includibgt not limited to damages for loss of goodwill, work
stoppage, computer failure or malfaioa, or any and all other commeatidamages or losses), even if
such Contributor has been advisediod possibility of such damages.

9. Accepting Warranty or Additiomd.iability.While redistributing the Work or Derivative Works

thereof, You may choose to offer, and charge a fee for, acceptance of support, warranty, indemnity, or
other liability obligations and/or rights consistevith this License.However, in accepting such
obligations, You may act only on Your own behalf amdYour sole responsibili, not on behalf of any
other Contributor, and only if You agree to indefyndefend, and hold each Contributor harmless for
any liability incurred by, or claims asserted agj such Contributor by reason of your accepting any
such warranty or additional liability.

END OF TERMS AND CONDITIONS
APPENDIX: How to apply the Apache License to your work.

To apply the Apache License to your work, attéod following boilerplatenotice, with the fields
enclosed by brackets "[]" replaced with your owandfying information.(Don't include the brackets!)
The text should be enclosed irethppropriate comment syntax the file format.We also recommend
that a file or class name andsdeiption of purpose be included tme same "printed page" as the
copyright notice for easier identifation within third-party archives.

Copyright [yyyy] [name of copyright owner]

Licensed under the Apache License, Version 2.0'{tieense”); you may not usis file except in
compliance with the License.You mabtain a copy of the License at

http://www.apache.org/licenses/LICENSE-2.0

Unless required by applicable law agreed to in writing, softwa distributed undethe License is
distributed on an "AS IS" BASIS, WITHOUT WARRNTIES OR CONDITIONS OF ANY KIND, either
express or implied.See the Licerfeethe specific language govengi permissions and limitations under
the License.

[http://www.apache.orditenses/LICENSE-2.0]

cglib
cglib is a powerful, high perfornmgze and quality Code Generation Libyalt is used to extend JAVA
classes and implements interfaces at runtime.
[http://cglib.ourceforge.net/]

License

Apache License

Version 2.0, January 2004

http://www.apache.org/licenses/

TERMS AND CONDITIONS FOR USEREPRODUCTION, AND DISTRIBUTION

1. Definitions.
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"License" shall mean the terms and conditionsuse, reproduction, andddribution as defined by
Sections 1 through 9 of this document.

"Licensor" shall mean the copyright owner or entitythorized by the copyrigltwner that is granting
the License.

"Legal Entity" shall mean the union of the acting enéityd all other entities that control, are controlled
by, or are under common control with that entity.Far plurposes of this deftion, "control" means (i)
the power, direct or indirect, to caeithe direction or managementsoch entity, whether by contract or
otherwise, or (ii) ownership offty percent (50%) or more of the atanding shares, or (iii) beneficial
ownership of such entity.

"You" (or "Your") shall mean an individual or al Entity exercising permissions granted by this
License.

"Source" form shall mean the preferred form fimetking modifications, inelding but not limited to
software source code, documentatsmurce, and configuration files.

"Object" form shall mean any forresulting from mechanical transfortian or translation of a Source
form, including but not limited to compiled objexde, generated documentatj and conversions to
other media types.

"Work" shall mean the work of authorship, whetheSiource or Object form, made available under the
License, as indicated by a copyright notice that ctuided in or attached to the work (an example is
provided in the Appendix below).

"Derivative Works" shall mean any work, whether imu$ce or Object form, that is based on (or derived
from) the Work and for which the editorial revisigmsnotations, elaborationsr other modifications
represent, as a whole, an original work of authiprétor the purposes of this License, Derivative Works
shall not include works that remaseparable from, or merely linkr{bind by name) to the interfaces of,
the Work and Derivative Works thereof.

"Contribution" shall mean any work of authorship;luding the original version of the Work and any
modifications or additions to th&York or Derivative Works thereof, &t is intentionally submitted to
Licensor for inclusion in the Work by the copyright owee by an individual ot.egal Entity authorized

to submit on behalf of the copyright owner.Foe thurposes of this definition, "submitted" means any
form of electronic, verbabr written communication sent to thecensor or its represtatives, including
but not limited to communication on electronic nirggl lists, source code control systems, and issue
tracking systems that are managed by, or on betfiathe Licensor for the purpose of discussing and
improving the Work, but excluding communication thatésspicuously marked or otherwise designated
in writing by the copyright ower as "Not a Contribution."

"Contributor” shall mean Licensond any individual or Legal Entitgn behalf of whona Contribution
has been received by Licensor and subsetiyiéncorporated within the Work.

2. Grant of Copyright Lldense.Subject to the terms and conditiohthis License, each Contributor
hereby grants to You a perpetual, worldwide, rawctusive, no-charge, royalty-free, irrevocable
copyright license to reproduce gpare Derivative Works of, publicdisplay, publicly perform,
sublicense, and distribute the Work and sDehivative Works in Source or Object form.

3. Grant of Patent License.Subject to the ternts @nditions of this Licese, each Contributor hereby
grants to You a perpetual, worlétke, non-exclusive, no-charge, rdtyafree, irrevocable (except as
stated in this section) patent licento make, have made, use, offesell, sell, import, and otherwise
transfer the Work, where such license applies onthose patent claims liceable by such Contributor
that are necessarily infringed byeth Contribution(s) alone or by conmation of theirContribution(s)
with the Work to which such Contribution(s) waghsnitted.If You institute pat# litigation against any
entity (including a cross-claim ooanterclaim in a lawsuit) allegintpat the Work or a Contribution

[ OL-26559-01-J
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incorporated within the Work constitutes directcontributory patent infrigement, then any patent
licenses granted to You under this License for that Vébid| terminate as of ¢hdate such litigation is
filed.

4. Redistribution.You may reproduce and distribute espif the Work or Derivative Works thereof in
any medium, with or without modidations, and in Source or Objdotm, provided that You meet the
following conditions:

(a) You must give any other recipients of the WorlDerivative Works a copy of this License; and
(b) You must cause any modified files to carry proamihnotices stating that You changed the files; and

(c) You must retain, in the Source form of any DetilveaWorks that You disthute, all copyright, patent,
trademark, and attribution noticekem the Source form of the Workxcluding those notices that do not
pertain to any part of the Derivative Works; and

(d) If the Work includes a "NOTICE" text file as paittits distribution, therany Derivative Works that
You distribute must include a readable copy of thétattion notices containedithin such NOTICE file,
excluding those notices that do nottaén to any part of the Derivat/Works, in at least one of the
following places: within a NOTICE text file distribed as part of the Derivative Works; within the
Source form or documentation, if provided alonghathe Derivative Works; or, within a display
generated by the Derivative Works, if and whenesuch third-party nates normally appear.The
contents of the NOTICE file are for informationalrposes only and do not modify the License.You may
add Your own attribution noticesitliin Derivative Works that Yodlistribute, alongsie or as an
addendum to the NOTICE text from the Work, providledt such additional attribution notices cannot
be construed as modifying the License.

You may add Your own copyright statement tau¥onodifications and may provide additional or
different license terms and conditiofts use, reproduction, or distribah of Your modifications, or for
any such Derivative Works as a whole, providediYose, reproduction, and distribution of the Work
otherwise complies with the conitins stated in this License.

5. Submission of Contributions.Urds You explicitly st& otherwise, any Coribution intentionally
submitted for inclusion in the Work by You to theensor shall be under the terms and conditions of
this License, without angdditional terms or conditions.Notwitlestding the above, nothing herein shall
supersede or modify the terms of any separaembe agreement you may have executed with Licensor
regarding such Contributions.

6. Trademarks.This License does grdnt permission to use the trade names, trademarks, service marks,
or product names of the Licensor, except as reqditmeckasonable and custorgarse in describing the
origin of the Work and reproducing the content of the NOTICE file.

7. Disclaimer of Warranty.Unlesgquired by applicable va or agreed to in writing, Licensor provides
the Work (and each Contributor provides@sntributions) on an "8 I1S" BASIS, WITHOUT
WARRANTIES OR CONDITIONS OFANY KIND, either express or implied, including, without
limitation, any warranties aronditions of TITLE,NON-INFRINGEMENT, MERCHANTABILITY, or
FITNESS FOR A PARTICULAR PBPOSE.You are solely responsible for determining the
appropriateness of using or redistributing the War@ assume any risks associated with Your exercise
of permissions under this License.

8. Limitation of Liability.In no event and under na@td theory, whether in tort (including negligence),
contract, or otherwise, ueds required by applicable law (suchdatiberate and grossly negligent acts)
or agreed to in writing, shall any @wibutor be liable to You for dangas, including any direct, indirect,
special, incidental, or corguential damages of any character arisiea@ result of thikicense or out of
the use or inability to use the Work (includibgt not limited to damages for loss of goodwill, work
stoppage, computer failure or malftioa, or any and all other commeatidamages or losses), even if
such Contributor has been advisedlod possibility of such damages.
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Velocity

License

9. Accepting Warranty or Additiom&.iability.While redistributing the Work or Derivative Works

thereof, You may choose to offer, and charge a fee for, acceptance of support, warranty, indemnity, c
other liability obligations and/aiights consistent with this License.However, in accepting such
obligations, You may act only on Your own behalf amdYour sole responsibili, not on behalf of any
other Contributor, and only if You agree to indefyndefend, and hold each Contributor harmless for
any liability incurred by, or claims asserted agj such Contributor by reason of your accepting any
such warranty or additional liability.

END OF TERMS AND CONDITIONS
APPENDIX: How to apply the Apache License to your work.

To apply the Apache License to your work, attéod following boilerplatenotice, with the fields
enclosed by brackets "[]" replaced with your owandfying information.(Don't include the brackets!)
The text should be enclosed irethppropriate comment syntax for the file format.We also recommend
that a file or class name andsdeiption of purpose be included tme same "printed page" as the
copyright notice for easier identifation within third-party archives.

Copyright [yyyy] [name of copyright owner]

Licensed under the Apache License, Version 2.0 '{tieense"); you may not ustis file except in
compliance with the License.You mabtain a copy of the License at

http://www.apache.org/licenses/LICENSE-2.0

Unless required by applicable law agreed to in writing, softwa distributed undethe License is
distributed on an "AS IS" BASIS, WITHOUT WRRANTIES OR CONDITIONS OF ANY KIND, either
express or implied.See the Licerisethe specific language govengi permissions and limitations under
the License.

[http://www.apache.ordicenses/LICENSE-2.0]

Velocity is a project of the Apache Software Fouinat® charged with the creation and maintenance of
open-source software relatedttee Apache Velocity Engine.

[http://velocity.apache.org/]

Velocity is a Java-based templapgine.lt permits anyone to uaesimple yet powerful template
language to reference objectsfined in Java code.

When Velocity is used for web development, web giesis can work in parallelith Java programmers
to develop websites according to the Model-Viear@oller (MVC) model, meaning that web page
designers can focus solely on ciegta site that looks good, apdogrammers can focus solely on
writing top-notch code.

[http://velocity.apache.orghgine/releases/velocity-1.6.2/]

Apache License

Version 2.0, January 2004

http://www.apache.org/licenses/

TERMS AND CONDITIONS FOR USEREPRODUCTION, AND DISTRIBUTION
1. Definitions.

[ OL-26559-01-J
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"License" shall mean the terms and conditionsufse, reproduction, andsdribution as defined by
Sections 1 through 9 of this document.

"Licensor" shall mean the copyright owner or enttythorized by the copyrigltwner that is granting
the License.

"Legal Entity" shall mean the union of the acting enéityd all other entities that control, are controlled
by, or are under common control with that entity.Far plurposes of this definition, "control" means (i)
the power, direct or indirect, to caeithe direction or managementsoch entity, whether by contract or
otherwise, or (ii) ownership offty percent (50%) or more of the atianding shares, or (iii) beneficial
ownership of such entity.

"You" (or "Your") shall mean an individual or gal Entity exercising permissions granted by this
License.

"Source" form shall mean the preferred form fimatking modifications, inelding but not limited to
software source code, documentatsmurce, and configuration files.

"Object" form shall mean any forresulting from mechanical transfortian or translation of a Source
form, including but not limited to compiled objextde, generated documentatj and conversions to
other media types.

"Work" shall mean the work of authorship, whetheSiource or Object formmade available under the
License, as indicated by a copyright notice that ¢tuided in or attached to the work (an example is
provided in the Appendix below).

"Derivative Works" shall mean any work, whether imu$ce or Object form, that is based on (or derived
from) the Work and for which the editorial revisiomsnotations, elaborationsr other modifications
represent, as a whole, an original work of authigrétor the purposes of this License, Derivative Works
shall not include works that remain separable frommerely link (or bind by name) to the interfaces of,
the Work and Derivative Works thereof.

"Contribution" shall mean any work of authorship;luding the original version of the Work and any
modifications or additionso that Work or Derivative Works thereof, that is intentionally submitted to
Licensor for inclusion in the Work by the copyright owee by an individual ot.egal Entity authorized
to submit on behalf of the copyright owner.Foe thurposes of this definition, "submitted" means any
form of electronic, verbal, or written communicatiomst the Licensor or iteepresentatives, including
but not limited to communication on electronic m@gjilists, source code control systems, and issue
tracking systems that are managed by, or on betiathe Licensor for the purpose of discussing and
improving the Work, but excluding communication thatésspicuously markear otherwise designated
in writing by the copyright ower as "Not a Contribution."

"Contributor" shall mean Licensor and any individoaLegal Entity on behaléf whom a Contribution
has been received by Licensor and subsetiyiéncorporated within the Work.

2. Grant of Copyright License.Subject to the teramd conditions of thisicense, each Contributor
hereby grants to You a perpetual, worldwide, rawctusive, no-charge, royalty-free, irrevocable
copyright license to reproduce gpare Derivative Works of, publicdisplay, publicly perform,
sublicense, and distribute the Work and such Derivative Works in Source or Object form.

3. Grant of Patent License.Subject to the termtb @nditions of this Licese, each Contributor hereby
grants to You a perpetual, worlétke, non-exclusive, no-charge, rdtyafree, irrevocable (except as
stated in this section) patent licento make, have made, use, offesell, sell, import, and otherwise
transfer the Work, where such license applies onthose patent claims liceable by such Contributor
that are necessarily infringed byeth Contribution(s) alone or by conmation of theirContribution(s)
with the Work to which such Contribution(s) wadsuitted.If You institute pat# litigation against any
entity (including a cross-claim ooanterclaim in a lawsuit) allegintpat the Work or a Contribution
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incorporated within the Work constitutes directoontributory patent infrigement, then any patent
licenses granted to You under thicénse for that Work shall terminads of the date such litigation is
filed.

4. Redistribution.You may reproduce and distribute espif the Work or Derivative Works thereof in
any medium, with or without modidations, and in Source or Objdotm, provided that You meet the
following conditions:

(a) You must give any other recipients of the WorlDerivative Works a copy of this License; and
(b) You must cause any modified files to carry proamihnotices stating that You changed the files; and

(c) You must retain, in the Source form of any DetilvaWorks that You disthute, all copyright, patent,
trademark, and attribution noticekem the Source form of the Workxcluding those notices that do not
pertain to any part of the Derivative Works; and

(d) If the Work includes a "NOTICE" text file as paittits distribution, therany Derivative Works that
You distribute must include a readable copy of théhattion notices containedithin such NOTICE file,
excluding those notices that do nottaén to any part of the DerivatvWorks, in at least one of the
following places: within a NOTICE text file distribed as part of the Derivative Works; within the
Source form or documentation, if provided alonghathe Derivative Works; or, within a display
generated by the Derivative Works, if and wheresuch third-party nates normally appear.The
contents of the NOTICE file are for informationalrposes only and do not modify the License.You may
add Your own attribution noticesitliin Derivative Works that Yodlistribute, alongsie or as an
addendum to the NOTICE text from the Work, providledt such additional attribution notices cannot
be construed as modifying the License.

You may add Your own copyright statement tau¥onodifications and maprovide additional or
different license terms and conditiofts use, reproduction, or distribah of Your modifications, or for
any such Derivative Works as a whole, providediYose, reproduction, and distribution of the Work
otherwise complies with the conitins stated in this License.

5. Submission of Contributions.Urds You explicitly st& otherwise, any Coribution intentionally
submitted for inclusion in the Work by You to thiensor shall be underehterms and conditions of

this License, without angdditional terms or conditions.Notwitlastding the above, nothing herein shall
supersede or modify the terms of any separambe agreement you may have executed with Licensor
regarding such Contributions.

6. Trademarks.This License does gaant permission to use the trade names, trademarks, service marks
or product names of the Licensor, except as reqdimeckasonable and customary use in describing the
origin of the Work and reprodutg the content of the NOTICE file.

7. Disclaimer of WarrantWnless required by applicable law oragd to in writing, Licensor provides
the Work (and each Contributor provides@sntributions) on an "8 1S" BASIS, WITHOUT
WARRANTIES OR CONDITIONS OFANY KIND, either express omplied, including, without
limitation, any warranties azonditions of TITLE,NON-INFRINGEMENT,MERCHANTABILITY, or
FITNESS FOR A PARTICULAR PBPOSE.You are solely responsible for determining the
appropriateness of using or redistributing the War@ assume any risks associated with Your exercise
of permissions under this License.

8. Limitation of Liability.In no event and under natd theory, whether in tort (including negligence),
contract, or otherwise, ueds required by applicable law (suchdatiberate and grossly negligent acts)
or agreed to in writing, shall any @wibutor be liable to You for dangas, including any direct, indirect,
special, incidental, or coeguential damages of any character arisis@ result of thikicense or out of
the use or inability to use the Work (includingt ot limited to damages for loss of goodwill, work
stoppage, computer failure or malftioa, or any and all other commeatidamages or losses), even if
such Contributor has been advisedhod possibility of such damages.

[ OL-26559-01-J
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9. Accepting Warranty or Additiom&.iability.While redistributing the Work or Derivative Works

thereof, You may choose to offer, and charge a fee for, acceptance of support, warranty, indemnity, or
other liability obligations and/or rights consistevith this License.However, in accepting such
obligations, You may act only on Your own behalf amdYour sole responsibili, not on behalf of any
other Contributor, and only if You agree to indefyndefend, and hold each Contributor harmless for
any liability incurred by, or claims asserted agj such Contributor by reason of your accepting any
such warranty or additional liability.

END OF TERMS AND CONDITIONS
APPENDIX: How to apply the Apache License to your work.

To apply the Apache License to your work, attédod following boilerplatenotice, with the fields
enclosed by brackets "[]" replaced with your owandfying information.(Don't include the brackets!)
The text should be enclosed irethppropriate comment syntax the file format.We also recommend
that a file or class name andsdeiption of purpose be included tme same "printed page" as the
copyright notice for easier identifation within third-party archives.

Copyright [yyyy] [name of copyright owner]

Licensed under the Apache License, Version 2.0 '{tieense"); you may not ushis file except in
compliance with the License.You mabtain a copy of the License at

http://www.apache.org/licenses/LICENSE-2.0

Unless required by applicable law agreed to in writing, softwa distributed undethe License is
distributed on an "AS IS" BASIS, WITHOUT WARRNTIES OR CONDITIONS OF ANY KIND, either
express or implied.See the Licerieethe specific language govengi permissions and limitations under
the License.

[http://www.apache.ordicenses/LICENSE-2.0]

Apache Commons

Components

License

The Commons is an Apache project focuse@lbmaspects of reusable Java components.

[http://commons.apache.org/]

The following components of Apache Corans pertain to this software license:
e Beanutils
« CLI
+ Codec
» Collections
» DbUtils
» Digester
e Lang
« Logging

Apache License
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Version 2.0, January 2004

http://www.apache.org/licenses/

TERMS AND CONDITIONS FOR USEREPRODUCTION, AND DISTRIBUTION
1. Definitions.

"License" shall mean the terms and conditionsufee, reproduction, andsdribution as defined by
Sections 1 through 9 of this document.

"Licensor" shall mean the copyright owner or engtythorized by the copyrigltwner that is granting
the License.

"Legal Entity" shall mean the union of the acting en#itd all other entities that control, are controlled
by, or are under common control with that entity.Fa plurposes of this deftion, "control" means (i)
the power, direct or indirect, to cseithe direction or managementsoch entity, whether by contract or
otherwise, or (ii) ownership offty percent (50%) or more of the atnding shares, or (iii) beneficial
ownership of such entity.

"You" (or "Your") shall mean an individual or gal Entity exercising permissions granted by this
License.

"Source" form shall mean the preferred form fisetking modifications, inciding but not limited to
software source code, documentatgmurce, and configuration files.

"Object" form shall mean any fornesulting from mechanical transfortien or translation of a Source
form, including but not limited to compiled objemtde, generated documentatj and conversions to
other media types.

"Work" shall mean the work of authorship, whetheSimurce or Object form, made available under the
License, as indicated by a copyright notice that ctuided in or attached to the work (an example is
provided in the Appendix below).

"Derivative Works" shall mean any work, whether imugce or Object form, that is based on (or derived
from) the Work and for which the editorial revisiommnotations, elaborationsr other modifications
represent, as a whole, an original work of authigr$tor the purposes of this License, Derivative Works
shall not include works that remaseparable from, or merely linkr{bind by name) to the interfaces of,
the Work and Derivative Works thereof.

"Contribution” shall mean any work of authorshipcluding the original version of the Work and any
modifications or additions to th&@Vork or Derivative Works thereof, #l is intentionally submitted to
Licensor for inclusion in the Work by the copyright owe by an individual ot.egal Entity authorized

to submit on behalf of the copyright owner.Foe fhurposes of this definition, "submitted” means any
form of electronic, verbabr written communication sent to thecensor or its represitatives, including
but not limited to communication on electronic niragl lists, source code control systems, and issue
tracking systems that are managed by, or on betiathe Licensor for the purpose of discussing and
improving the Work, but excluding communication thatamspicuously marked or otherwise designated
in writing by the copyright ower as "Not a Contribution.”

"Contributor” shall mean Licensond any individual or Legal Entitgn behalf of whorma Contribution
has been received by Licensor and subsetyécorporated within the Work.

2. Grant of Copyright ldense.Subject to the terms and conditiohthis License, each Contributor
hereby grants to You a perpetual, worldwide, eaxctusive, no-charge, royalty-free, irrevocable
copyright license to reproduce gmare Derivative Works of, publicdisplay, publicly perform,
sublicense, and distribute the Work and sDefmivative Works in Source or Object form.

3. Grant of Patent License.Subject to the ternts @nditions of this Licese, each Contributor hereby
grants to You a perpetual, worlde, non-exclusive, no-charge, rdtyafree, irrevocable (except as
stated in this section) patent licento make, have made, use, offesell, sell, import, and otherwise
transfer the Work, where such license applies onthose patent claims liceable by such Contributor

[ OL-26559-01-J
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